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1

Copyright Notices

Copyright©2021 — Expertdx, all rights reserved. ThiseBook isintended for the purchaser’s personal use only.
No part of this eBook may be reproduced or transmitted in any form whatsoever, electronic, or mechanical,
including photocopying, recording, or by any informational storage or retrieval system without expressed written
permission from Expert4x.

Copyright©2021 EAfactory, all rights reserved. All title, including but not limited to copyrights, in and to the
theTradeableADX EA and any copies thereof are owned by EAfactory or its suppliers. All title and intellectual
property rightsin and to the content which may be accessed through use of the theTradeableADX EA isthe
property of the respective content owner and may be protected by applicable copyright or other intellectual
property laws and treaties. All rights not expressly granted are reserved by EAfactory. For the full details please
refer to the End-User License Agreement ("EULA").



Chapter

2

Getting Started with thetheTradeableADX EA

Getting Sarted provides a guided exploration of the theTradeableADX EA. It is geared for an audience that has
little or no knowledge of installing an MT4 EA. It walks the novice user through downloading and installing the
theTradeableADX EA.

2.1 Installing thetheTradeableADX EA

The theTradeableADX EA comes with a setup application to provide a wizard based installation process to the
selected MT4 terminal.

Beforeyou start...

» Ensurethat you have the login credentials to the Web Support Centre.
» Ensurethat you have an MT4 terminal version 4.00 build 1320 or later installed.

1. Exit MT4if it was running.
2. Loginto the Web Support Centre.

= O X
&«» Web Support Centre b4 +
&« C &* https://my.eafactory.com/expertdx “
Login
Login name :  Login name
Password :  Password
Login
Login name recovery
Password recovery
Services powered by EAfactory.com - Copyright © 2008-2020 EAfactory.com - . . .
vd 50 Terms and Conditions ~ Privacy Policy.
L4

3. Scroll down and click on the theTradeableADX EA in the Product List.

Product List

EXPEH4X theTradeableADX &

[ SN I .

4. Click on the Product Download button to download the EA setup.
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Release List

theTradeableADX MTS5 v | Users Guide || Product Download |

theTradeableADX MT4 v | Users Guide || Product Download |

5. Run the setup application. Select the M T4 instance during setup to where you want the service installed.

6. When setup completes start up MT4. The theTradeableADX EA entry should appear under the Expert
Advisors node in the Navigator window (View > Navigator)

These pictures highlight the steps how to install the EA.

]ﬁl Setup - theTradeableADX MT4 EA - bt

Welcome to the theTradeableADX
MT4 EA Setup Wizard

This will install theTradeableADX MT4 EA version on your
computer.,

Itis recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

ﬁ%’ Setup - theTradeableADX MT4 EA —

Select Target MetaTrader Directory
Far which MT4 location should theTradeableADX EA be installed?

Setup will install the theTradeableADX EA under the selected MT4 instance.

() ci\Program Files (x86)\MetaTrader 4 IC Markets's Data Folder ~
(O) C:VProgram Files (x86)\ThinkForex Australia MetaTrader 4's Data Folder

(O) C:\Program Files (x86)\OANDA MetaTrader's Data Folder

(O c:\Program Files (x86)\MetaTrader 4's Data Folder

() CiVProgram Files (x36)Tallnex MetaTrader 4 - 01's Data Folder

() C:\Program Files (x36)\MetaTrader 4 FinFi's Data Folder

C:\Program Files (x86)\Blueberry Markets MetaTrader 4 Terminal's Data
O Folder

() CiVProgram Files (x86)\MetaTrader - RoboForex's Data Folder

(O) CiVProgram Files (x86)\Tallinex MetaTrader 4 - 02 - mg's Data Folder

(O) C:VProgram Files (x36)\MetaTrader - AxiTrader's Data Folder

(O) C:VProgram Files (x86)\MetaTrader's Data Folder

~ C:\Proaram Files (x86Y\Blueberrv Markets MetaTrader 4 Terminal - ug's Data ¥

< Back Mext = Cancel

The setup application lists the available M T4 instances. Select one of them for installation target and click on the
Next.

Note:

For some earlier version Windows version the list may not contain all the MT4 instances. In this case use the
Add target directory... button to navigate and pick up the desired folder.
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ﬁl Browse For Folder *
Select Ta
For whig  Select a MT4 target folder in the list below, then didk OK
Setup w v MetaTrader A | [stance.
O config
O history Er
Qc MaLd
O 2 il
O c: profiles
O Sounds
O templates
O MetaTrader - AxiTrader
MetaTrader - RoboForex
MetaTrader 4 FinFX.
MetaTrader 4 1C Markets N
< > ictory.
Coce
Cancel

C.\ Program Fi | es\ Br oker Speci fi cNane\

Getting Started with the theTradeableADX EA

but you may have selected something else while performing the MetaTrader installation. As a hint, the following

shows you the default path to the main M T4 directory for some brokers:

Broker Default Path
Blueberry Markets broker C:\Program Files (x86)\Blueberry Markets MetaTrader 4 Terminal
Dukascopy broker C:\Program Files (x86)\Dukascopy MetaTrader 4
|G broker C:\Program Files (x86)\IG MetaTrader 4 Terminal
OANDA broker C:\Program Files (x86)\OANDA - MetaTrader
Pepperstone broker C:\Program Files (x86)\Pepperstone MetaTrader 4

ﬁ%’ Setup - theTradeableADX MT4 EA —

Select Start Menu Folder
Where should Setup place the program's shortcuts?

|j Setup will create the program's shortcuts in the following Start Menu folder.
[ -]

To continue, dick Next. If you would like to select a different folder, dick Browse.

| rt4x\theTradeable ADX Browse...

Always select the main MT4 folder itself for installation target, not any of its sub-directories.

When the installation is compl ete, start up MT4 and check that the EA appears in the Navigator window (View >

Navigator):
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- [m] X

@ 19974105: Eightcap-Demo - Demo Account

File View Tools Help

B B[R ¢ B | Grevone & B @ [Gavoteing |1 0 1 [@ A Bnr|G-0-2-] 2O
’T —}—| | — 7 @ & a T ?z,v%Ml ME  MIE M30’TH4 DI W1 MN

Navigator

[ BBM MT4

a Accounts
Indicators

: Expert Advisors

22 MACD Sample

% Moving Average

"% theTradeableADX
- iy

| Wi 2171 kb

Common | Favorites

For Help, press F1

So everything is set up for the first activation of the theTradeableADX Expert Advisor

| Default

2.2theTradeableADX Expert Advisor First Time Activation

Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the theTradeableADX Expert Advisor inafew

steps.

Attach the EA to achart
1. Drag & drop thetheTradeableADX Expert Advisor from the Navigator window (View > Navigator) to a

chart window and select the Common tab:
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te 1 5: Eightcap-Demo - Deme Account - [EURUSD,H1] — O
File  View nsert Charts Tools Nindov Hel - & x
BB [[R ¢ B | GNwOder & B (9 [GAutoTading {11, 18 @ @ BD[1|G-O-B- £ O
\_:_|| _/195: A ?z,v;rm M5 MIE M0 | HI H4 D1 WIMN|
Market Watch: 16:33:33 * |[+ EURUSD.HL 1.20656 1.20685 120624 120547 theTradesbleADX ()
Symbol Bid Ask ™ 122225
4 USDCHF 0.89133 0.89144 ll“m
1.72050
% GBPUSD 1.33470)  1.35489 |HH |
i EURLSD 120847 | Expert - theTradeableADX T X La1sss
& USDIPY 103.730
2 USDCAD 127713 About  Commen |nputs  Dependencies 121825
% AUDUSD 076785 Commen Safety L1690
4 EURGBP 080047
it AMlow DLL import:
Symbols [ Tick Chart | ConE | postions B4 Alow DLL imports 121555
= Enable alerts AMllow import of extemal experts
P - ; 1.21425
BEM MT4 [ Disable alert onc hit [] Allow modification of Signals settings
@] Accounts 121750
'?! Indicators Live Trading
=% Expert Advisors 121155
i %R MACD Sample
% Moving Average 121025
%2 theTradeableADX
4 Scripts Cancel Reset 120830
IUUHP l”‘ “l ‘ 1,20755
B T T T T T T T 1.20420
Common | Favorites 113en 2021 12Jen 0500 12 J2n 2000 13Jen13:00 14 Jen 0500 14 J2n 2000 15 Jen 13:00 18 Jan 05:00
For Help, press F1 Default | Wi 17171 kb A
Note:
Ensure that the
* Allow livetrading,
e AllowDLL import and
e Allowimport of external experts
areticked.
Select the I nputstab:
Ce 19974105: Eightcap-Demo - Deme Account - [EURUSD,H1] — O
File  View nsert Charts  Tools  Windov Help - & X
G- 5B O B | GNevoder & B (@ [GAuoTeding |12 18 |[@ @ B[P O-B- » O
\—:—|| -/ # A ML M5 MIS M0 | HI H4 D1 WIMN|
Market Watch: 15:46:26 * |[+ EURUSD,HL 121355 1.21406 121229 1.213%4 theTradeshlet DX (D)
Symbal Bid Ask L2
% USDCHF 0.88653 0.83663 l[”m
122090
% GBPUSD 1.36153|  1.36171 HIH |
A EURUSD 121354 | Expert - theTradeableADX ? X La1sss
& USDIPY 103.872
& USDCAD 1.27302 About Common Inputs  Dependencies La1gzs
& AUDUSD 0.77168
~ 1.71850
2 EURGEP 089151 Varable _ _ Value
Symbols | Tick Chart | ] === ADX Indicatar Setings 121585
= Lg:_:: Entry Method [dropdown] ADX Trend & Direction
ADX Period [»=. 12
BEM MT4 = eoc 2] r EEiER
: |ied] ADX Level [>=0] 25
& Accounts 121750
[# Indicators L;_:: Trend Following Method [dropdown] Start of Trend: One Entry '
- 22 Expert Advisors [Eza Posttion Action upon Trend Change [dr... Close All Previous Trend's Positions Load 1.71155
i ‘% MACD Sample b,?_zj Position Action upon ADX Decline [dro...  Keep All Positions Open
‘% Maoving Average 3!33 ====Common Settings Y] Save 1.31025
.. %% theTradeableADX
5, Scripts Cancel Reset 1.20850
e -
||‘||l -
B T T T T T T T 120430
Common | Favorites 121an 2021 13Jan 04:00 13Jan 20:00 14Jan12:00 15Jan 0400 15Jan20:00 18 Jan 12:00 19 Jan 000
For Help, press F1 Default | A
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Thislists the parameters of the EA where the operational aspect of the theTradeableADX EA can be set up.
For more details see the theTradeableADX EA Configuration Guide —for now click on the OK button and
let the EA start up with default settings.

Note:
At the very first time the EA may prompt for the Access ID to verify that the usage of product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support site. Feel free to
change your Access ID at the Web Support Centre and ensure not to share it with anyone else. Enter the
Access ID and click on the Save button:

Unlknown Access |D. Please enter
! k. valid Access |0,

Product:

Provider:

Access |0

Save Cancel

Dialog closesin Z2min 2 seconds

ThetheTradeableADX EA isup and running
After successful authentication the theTradeableADX EA starts up.
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C@ 19962789 Eightcap-Demeo - Demo Account - [EURUSD,H1] — O X
File  View Inset Charts Tools Window Help -8 %
G - R~ & ’g El ﬂ | Ia.NewOrder & B g |@AutoTrading EIE 9 | ® < ||— yol __o

k —}—| | — ~ @ ¥ a ?f,vér\-n MS MIS M30 | H1 Hé D1 wi MN‘
Market Watch: 15:51:36 % |[+ EURUSD,HL 1.21755 1.21409 1.71779 1.71384 theTradesbleA DX () [ 1.22250
Symbol Bid Aske ™
& USDCHF | 0.88691 0.88703 theTradeableADX v1.0.0 177180
¥ LBa7
o GBPUSD | 1.36147 136163 R (- fonfiny) (At (NEaked) (Exemstion )
4 EURUSD | 1.21334| 1.213%4 theTradeableADX v1.0.0 on EURLSD H1 wimagic 191210
& UsDIPY 103.292| 103.905 Status: Enabled Access: 512878483-1-0-0@13:49:20 Licensed until: unlimited 171950
@ USD.. | 127310 1.27327 - BA Infe
_— P— Stage - Monitoring Entry 1.71890
# AUD... 0.77158) 0.77172 Active - Buy: 0 Sell:0 = Total:0 cut of 5 Max
4 EURGEP 0.89149 0.89162 Setup - ADX[12) Trend+Direction
Setup - Pos:Close All; ADX:Keep All; Trend:One Entry 121730
4 EURAUD | 157301 1.57321 Filter - Spread:<=5pips Days:Su Mo Tu'We Th Fr Sa Time:0:00 - 24:00
& EURCHF | 1.07658 1.07674 Risk - Manual 0.01 lots; InitSL:120pips; Bresk'e:50 lodk:230pips; TP:120pips 1.21650
Trailing - Start:60 Stop:40 Step:10pips
& EURJPY | 126.114/| 126.125 Dynamic- Target Start:50 Step:10pips; Stop Start:50 Step:10pips
& GBPCHF | 120757/ 120788 \ Spread - 1.0 Gurent vs 5.0 pips Limit = 20% into suspension 1.21550
W
e AN Trading O fiew
Symbols | Tick Chart | r\r:-ad::ec lfanc::':c- far L1450
Navigator x

BBM MT4
Elﬁ Accounts

— Floating Profit and Loss

Buy Orders - Count:0 Lots:0.00 P&L Pips:0.0 USD:0.00 C&Swap:0.00

Sell Orders - Count:0 Lots:0.00 P&L Pips:0.0 USD:0.00 C&Swsap:0.00 121230
E| ]E Eightcap-Demo Total Floating - Count:0 Lots:0.00 P&L Pips:0.0 WSD:0.00 C&Swap:0.00
&) 19906725: Demo A 121190
— Account Level Info
L &) 19962780: Demeo A Femu e
¥ Indicatars Margin:0.00 Free Margin%:100.00 Margin Call 8t:50% Leverage: 100 121080
- L ) Balsnce:10000.00 Equity:10000.00 P&L USD:0.00 Equity%:100.00
-8 Expert Advisors
2 MACD Sample — Market Info |} ] L
2 Moving Average Spread - Cument: 1.0 Avg:1.0 Max:1.1 at Server Time:2021.01.19 15:49:58 * [
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The theTradeableADX Expert Advisor has been attached to the chart. The smiley face in the top-right corner
shows that the initialisation of the theTradeableADX Expert Advisor was successful and the EA is now looking

for trading opportunities.

See the smiley face in the corner:

Lo B e

I theTradeable ADX () I

122750

In case of a problem getting the EA up and running please refer to the Knowledgebase section.
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Chapter

3

System Requirements

Overview of prerequisitesin order to install and get the product up and running.

3.1 Operating System Requirements

In order to operate the theTradeableADX EA a Microsoft Windows operating system is required which supports
MetaQuotes MetaTrader version 4.00 platform.

Note that the M etaQuotes MetaTrader software is aso known and often referred to as MT4.

3.2 Hardwar e Requirements

The minimum Random Access Memory (RAM) requirement is 512MB (0.5GB), however 1024MB (1GB) RAM
is recommended to avoid extended virtual memory usage. Note that this memory requirement is for MetaTrader
application only, excluding other applications running at the same time (e.g. MS Office). If other applications are
running parallel with MetaTrader application please increase the RAM requirement accordingly.

3.3 MetaTrader (MT4) Requirements and Settings

The EA is compatible with MetaQuotes MetaTrader platform version 4.00 build 1320 or higher. In generd thisis
referred to asM T4 terminal, build 1320 or newer.

3.4 Forex Broker Requirements

The theTradeableADX EA is compatible with both 4 and 5-digit data feeds based brokers. The theTradeableADX
EA automatically detects the type of the feed and adjusts the EA parameter pip values if and when necessary.

Both fixed and variable spread broker platforms are supported.

The selected MetaTrader based broker should allow keeping open orders on the account for long period of time,
i.e. the broker should not close and re-open orders over night for swap calculation, or should not merge open
orders for any reason.

IMPORTANT: For smooth trade management the MetaTrader application and the EA should be on-line, up and
running during all market open hours (usualy Sunday to Friday).

3.5 Hedging Support Requirements

When the theTradeableADX EA is attached to charts with both BUY and SELL trades enabled, the EA may keep
open BUY aswell as SEL L positions at the same time on the same market. In this situation the broker account
must support the hedging of trades.

Hedging support is not required only if the EA is attached to the market with either BUY or SELL enabled, but
never both at the same time.
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3.6 Non-FIFO Support Requirements

When the theTradeableADX EA is attached to charts with both BUY and SELL trades enabled, or maximum
allowed open trades higher than 1 configuration, the EA may open and close positions out of order of the first-

in-first-out (FIFO) sequence. In this situation the broker account must support the order handling in non-FIFO
manner.

FIFO is supported only if the EA is attached to the market with either BUY or SELL enabled (never both at the
same time) and maximum allowed open tradesis set to 1.

3.7 Account Type and Minimum L ot Size Requirements

A so-called Micro broker account is necessary if the available funds for the EA trading is less than approx. $1000.
The micro account allows the EA to open a position with minimum lot size of 0.01. If you plan to use a broker
account with the above funding please ensure that your broker account offers this minimum lot size.

An easy way to double check the minimum lot size available on the broker account isto attach the EA to achart
and check the Market Info section on the chart:

larket |Info

Spread - Cument:1.3 Awvg:1.2 Max:1.2 at Server Time:2019.12.13 23:52:00
Lot - Size: 100K Min:0.01 Step:0.01 Margin req:370.88 Pip value:US5D 10.00

The Lot line shows Min:0.01 which tells that the minimum lot size requirement is 0.01 on this broker account.
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Chapter

A

theTradeableADX EA Configuration Guide

The theTradeableADX EA configuration guide.

In order to activate the theTradeableADX EA attach it to a chart window — for more details see theTradeableADX
EA First Time Activation section.

4.1 Configuration and Operation Principles
The theTradeableADX EA operational overview.

The theTradeableADX EA manages only those tickets (a.k.a positions) on the account which belong to the
theTradeableADX EA: every order submitted to the account is marked with the Magic Number and, in return,
only those tickets on the account will be considered by the theTradeableADX EA which are marked with this
Magic Number.

In general it is recommended to run on an account one EA at atime. This helps understanding the ongoing trades
and troubleshoot situation if and when needed.

While this maybe feasible for demo accounts this may not be feasible for live accounts where there could be the
need to execute multiple expert advisors on the same account at the same time.

Using multiple expert advisors on the same account is only viable if each and all expert advisor will follow the
above Magic Number principle and they manage only their own tickets on the account.

IMPORTANT: If you plan to use multiple expert advisors (other than the theTradeableADX EA) on the
same account please ensure upfront with the expert advisor providersthat their EA'sare suitable for that
as per the above.

If you plan to use multiple theTradeableADX EA's on the same account at the same time please ensure that the
Magic Number is set to different and unique number for each chart of the same market.

Here are few examples:

Market MagicNumber
EURUSD chart 1 92000
EURUSD chart 2 92001
EURUSD chart 3 92002
GBPUSD chart 1 92010
GBPUSD chart 2 92011
GBPUSD chart 3 92012

USDCAD single chart EA default or any other
USDCHF single chart EA default or any other

4.2 theTradeableADX EA Parameter Descriptions

The theTradeableADX EA parameter descriptions.
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4.2.1 ADX Indicator Settings

Expert - theTradeableADX ? et

fbout Common  INputs  Dependencies

Variable Value 2
ab | ==== ADX Indicator Settings ================s===ss============
|1a-3n| Entry Method [dropdown] ADX Trend & Direction
i3] ADX Period [»=2] 12
i3] ADX Level [>=0] 25
|1a-3°| Trend Fallowing Method [dropdown] Start of Trend: One Entry
|1a-3'}| Position Action upon Trend Change [dr... Close All Previous Trend’s Posttions Load
|1a-3'}| Position Action upan ADX Decline [dro... | Keep Al Postions Open
ab | ==== Common Settings e Save

Cancel Reset

Entry Method

Entry Method
Selects the way of new position entry.

2] Entry Method [dropdown] ADX Trend & Direction v

AD¥ Direction On
AD¥ Trend & Direction
ADX Trend & Level & Direction

Entry Method Description

The +DI and -DlI lines of the ADX indicator determine the direction of the trend
and new trade:

* BUY isentered when:

1. The +DlI isabovethe -DI. This marks the UP trend direction.
e SELL isentered when:

1. The-DlI isabove the +DI. This marks the DOWN trend direction.

ADX Direction Only

The +DI & -DlI lines alongside with the slope of the ADX main line determines
the trend and new trade:

* BUY isentered when:

1. The +DlI isabovethe -DI. This marks the UP trend direction.
ADX Trend & 2. The ADX main line slopes upwar d.
Direction e SELL isentered when:

1. The-Dl isabove the +DI. This marks the DOWN trend direction.
2. The ADX main line slopes upwar d.

In both cases the ADX main line must slope upward to confirm anew trade in
the direction of the +DI/-DI trend.
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Entry Method Description

On top of the +DI & -DI lines and the slope of the ADX main line, the reading of
the ADX main line determines the trend and the new trade:

* BUY isentered when:

1. The +DlI isabove the -DI. This marks the UP trend direction.
2. The ADX main line slopes upwar d.

ADX Trend & Leve & 3. The ADX mainlineison or abovethe ADX Level.
Direction e SELL isentered when:

1. The-DlI is above the +DI. This marks the DOWN trend direction.
2. The ADX main line slopes upwar d.
3. The ADX mainlineison or abovethe ADX Level.

In both cases the ADX main line must slope upwar d and must be on or above
the ADX Level to confirm a new trade in the direction of the +DI/-DI trend.

ADX Period

ADX Period
Used for and corresponds to the ADX indicator's period parameter.

ADX Level

ADX Level

Corresponds to the ADX indicator main line's reading. The EA uses this ADX main line reading in order to filter
new trade entry when the ADX Trend & Level & Directionoption is selected for the Entry Method.

Trend Following M ethod

Trend Following Method
Selects the way the identified trend gets traded:

3] Trend Following Method [dropdown] Start of Trend: One Entry ~
Start of Trend: One Ents
With the Trend: M.,"l’.t,lEle Entry
Trend Following Method Description
Start of Trend: One Only one new trade is entered when the direction of the trend changes. Thistrade
Entry is entered when the +DI & -DlI lines of the ADX indicator cross each other.
With the Trend: A new trade is entered in the direction of the current trend upon every new bar
Multiple Entry opening.

Note: For more information how the trend gets identified see the Entry Method.
Position Action upon Trend Change

Position Action upon Trend Change

Determines what happens to the open positions when the +DI & -DI lines of the ADX indicator cross each other
resulting in the change of the trend:

Iﬁﬂ Position Action upon Trend Change [dr... | Close All Previous Trend’s Positions w~

Keep Al Posttions Open
Close Al Previous Trend's Positions
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Position Action

upon Trend Change Description

Keep All Positions Open them off upon trend change.

Existing positions are |eft open on the account, the EA does not close

Positions off by the EA upon trend change.

Close All Previous Trend's All existing positions in the direction of the previous trend gets closed

Note: For more information how the trend gets identified see the Entry Method.
Position Action upon ADX Decline

Position Action upon ADX Decline

Determines what happens to the open positions when the main line of the ADX indicator slopes downward:

,1a;}| Position Action upon ADX Decline [dro... | Keep All Positions Open

=ep All Positions Open
Close Al Postions
Cloge Cument Trend’s Pasitions
Close Previous Trend’s Positions

Position Action

upon ADX Decline Description

Keep All Positions Open them off upon ADX main line's decline.

Existing positions are left open on the account, the EA does not close

Close All Positions )
decline.

All existing positions gets closed off by the EA upon ADX main line's

Close Current Trend's Positions EA upon ADX main line's decline.

All existing positionsin line with the current trend gets closed off by the

Close Previous Trend's Positions

upon ADX main line's decline.

All existing positions against the current trend gets closed off by the EA

Note: For moreinformation how the trend gets identified see the Entry Method.

4.2.2 Common Settings

Expert - theTradeableADX

fbout Common  Iputs  Dependencies

Variable Value 2
ab | ==== Common Settings e

ab | — Trade Limits

li2 | Max Spread for Position Entry, Pips ho

,1a3}| Max Total Trades Open at a Time [==0] |5

|123] Action When Max Trades Limit Reach... No New Trade Entry

ab | ==== Position Management SRS ——
,12-3'}| Direction of Trade Ertry [dropdown] Same as Trigger Direction (Buy Trigger=:B...
,1a?| Initial 5L for Mew Posttion, Pips [0:0ff] 120 v

Load

Save

Reset
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Max Spread for Position Entry

Max Spread for Position Entry

The maximum value of the current market spread the EA is allowed to perform market entry, i.e. to open anew
position. If the current spread of the market exceeds this limit then the EA will not consider to open position until
after the spread drops to or below this value.

Max Total Trades Open at a Time

Max Total TradesOpen at a Time

The total number of open buy plus sell trades together is limited to this maximum number al the time. How this
limit is applied to the trading logic is determined by the Action When Max Trades Limit Reached.

Example: | want to limit the number of open buy and sell trades together to 10. When this limit is reached | want
no more trades to be entered until one of the open trades gets closed by their stop or change in the trend direction.

Hereisan EA configuration to achieve the above:

1. Max Total TradesOpen at aTime =10
2. Action When Max Trades Limit Reached = No New Trade Entry
3. Position Action upon Trend Change = Close All Previous Trend's Positions

Example: | want to limit the number of open buy and sell trades together to 10. When this limit is reached |
want the new trade to replace the existing open trade with the highest profit, i.e. at the time of the new trade entry
closing off the existing open trade with the highest profit.

Hereisan EA configuration to achieve the above:

1. Max Total TradesOpenat aTime=10
2. Action When Max Trades Limit Reached = Close Most Profitable Trade

Action When Max Trades Limit Reached

Action When Max Trades Limit Reached

Determines which existing open buy or sell trade gets closed off when the Max Total Trades Open at aTime
count is already reached and the EA is about to enter a new trade.

.‘Eﬂ Action When Max Trades Limit Reach... |No New Trade Entry

Mo Mew Trade Ent
Close Most Profitable Trade
Close Qldest Trade

Action When Max

Trades Limit Reached DESEE e

No new trades are entered once the Max Total Trades Open at a Time is reached.
No New Trade Entry Existing open trades are still managed, those may hit their target or stop levels,
or trailing stops.

The open trade, either buy or sell, with the highest profit amount gets closed

Close Most Profitable out. If all the open buy and sell trades are in |osses then the one with the least
Trade

amount of losses gets closed out.
Close Oldest Trade The open trade, either buy or sell, with the oldest creation date gets closed out.

In order words the open trade with the lowest ticket number gets closed out.
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Expert - theTradeableADX ? et
fbout Common  INputs  Dependencies

Variable Value 2

|ab] ==== Position Management ===================s=s===========

[1}33 Direction of Trade Entry [dropdown] Same as Trigger Direction (Buy Trigger=:B...

hgzj Intial 5L for Mew Posttion, Pips [0:0f] 120

iad] Take Profit, Pips [0:0ff] 120

|ab| — Position Sizing

[1}33 Position Sizing Method [dropdown] Manual Lot Size

%Y Initial Risk Percent [>0] 1.0

%Y Lots for "Manual Lot Size' 0.01

|ab | — Breakeven

[1233 Move SLto Breakeven at Profit, Pips [.. 50

[1}33 Lock-n Proftt at Breakeven Mave, Pip... 30

|ab | — Trailing Stop

lted] Trailing Start at Profit, Pips [0:Off] 50

e8] Traiing SL, Pips [>=1] 40 Load

[y}j Trailing Stepping, Pips [>=1] 10 W Save

Cancel Reset
Expert - theTradeabledDX ? X
About  Common  Inputs  Dependencies
Variable Value 2

|ab | — Trailing Stop

liad] Trailing Start at Profit, Pips [0:Off] 50

liad] Trailing SL., Pips [>=1] 40

[@ Trailing Stepping, Pips [>=1] 10

|ab | — Dynamic Stop

fted] Dynamic Stop Start at Profit, Pips [0:0ff] | 50

[1;:3 Dynamic Stop Stepping, Pips [==1] 10

|ab| — Dynamic Target Load

[1}33 Cynamic Target Start at Loss, Pips [0:... 50

hgzj Dynamic Target Stepping, Fips [>=1] 10 W Save

Cancel Reset

Direction of Trade Entry

Direction of Trade Entry

Option to reverse or not a trigger when a new position entered.
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,1aﬁ Direction of Trade Entry [dropdown] Same as Trigger Direction (Buy Trigger=:

Same as Trigger Direction
Reverse Trigger Direction (Buy Trigger=:5ell

Direction of Trade Description

The new tradeisin line with the trigger:

Same as Trigger Direction * Buy trigger -> opens a buy position

e Sl trigger -> opens a sell position

The new trade is the opposite direction of the trigger:

Reverse Trigger Direction * Buy trigger -> opens a sell position
e Sl trigger -> opens a buy position

Initial SL for New Position

Initial SL for New Position, Pips

The Stop Loss value in pips for anew position, set after market entry. When configured as zero then no Stop Loss
is set for new positions.

Example: | want to have Stop Loss of 60 pips after entering a new trade. | want to take profit of 100 pips gain off
the trade.

Hereisan EA configuration to achieve the above:

1. Take Profit = 100
2. Initial SL for New Position = 60

Take Profit

Take Profit, Pips

Target profit value in pips for a new position, set after market entry. When configured as zero then no Take Profit
is set for new positions.

Example: | want to take profit at 100 pips gain after entering a new trade. The Stop Loss for the trade is 60 pips.
Hereisan EA configuration to achieve the above:

1. Take Profit = 100
2. Initial SL for New Position = 60

Position Sizing
Position Sizing M ethod

The position sizing mechanism used for new trades at market entry.

Position Sizing Method Description

Thelots for new position is calculated based on

» Free Margin available on account, and
 Initial Risk Percent, and
Percent of Account Free Margin » Initial SL for New Position

The lots for the new position is calculated in away that should the

initial SL get hit the loss would not be higher than the risk percent of
the free margin.
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Position Sizing Method

Description

Percent of Account Equity

Thelots for new position is calculated based on

e Equity available on account, and
* Initial Risk Percent, and
» Initial SL for New Position

The lots for the new position is calculated in away that should the
initial SL get hit the loss would not be higher than the risk percent of
the equity.

Percent of Account Balance

The lots for new position is calculated based on

» Balance available on account, and
* [nitial Risk Percent, and
e [nitial SL for New Position

The lots for the new position is calculated in away that should the
initial SL get hit the loss would not be higher than the risk percent of
the account balance.

Manual Lot Size

The lots for the new position is not calculated by the EA, instead it is
fixed and set to the user-defined value from Lots for ‘Manual Lot Size'.

The position sizing calculation takes place at the time of market entry, when al the entry criteria are met.

The calculated lots value is normalized according to the minimum lots size and lots stepping requirements of

the MT4 terminal. Therefore the actua risk amount may vary and will be a best effort and approximate of the

configured target risk value.

When the calculated lots value is higher than the broker maximum allowed lot size, the EA truncates the lots to

the maximum allowed figure and carries on with this capped lots value.

Furthermore, the market conditions (e.g. fast price movements) or the M T4 operational conditions (e.g. lost

connectivity to broker) may alter the actua exit point of an open trade, resulting in higher or lower actual risk

compared to the configured target risk value.

Initial Risk Percent

Determines the risk amount allocated to a new trade as a percent of the broker account value. For more details see

the Position Sizing Method.

Lotsfor ‘Manual Lot Size

Setsthe fixed lot size for new positions to this user-defined value when the Manual Lot Sze option is selected for

Position Sizing Method.

Breakeven

Move SL to Breakeven at Profit, Pips

The EA moves an existing open position's stop loss to break even (i.e. its entry price) when the position gets into

profit by at least this Move SL to Breakeven at Profit pips.
This breakeven feature can be turned off by setting the Move SL to Breakeven at Profit to zero value.

L ock-in Profit At Breakeven, Pips

This EA parameter works together with the Move SL to Breakeven at Profit. When an existing open position

getsinto profit by at least Move SL to Breakeven at Profit pips, then the position's stop loss gets moved to break
even point, and potentialy further offset it into profit by the number of pips specified by this Lock-in Profit At

Breakeven Move parameter.
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Assuming the following configuration:

* Move SL to Breakeven at Profit = 10
* Lock-in Profit At Breakeven Move = 2
* Anexisting buy position with open price of 1.1200 getsinto profit by 11 pips.

Because the open position reached the minimum profit level of 10, the EA moves the stop lossto 1.1202 which is
break even plus 2 pips of profit lock-in.

Note: If the Lock-in Profit At Breakeven Move was set to zero then the stop loss would bed to break even of
1.1200.

Trailing Stop

Trailing Start at Profit, Pips

The EA starts off the trailing of price by moving an existing open position's stop loss when the position gets into
profit by at least this Trailing Start at Profit pips. Once the trailing got activated, the SL gets adjusted every time
when the price moves further and the position gets further into profit by Trailing Stepping pips. Refer to Trailing
SL and Trailing Stepping for more details.

Trailing SL, Pips

When trailing feature is activated, the SL of the position is set by this amount of pips behind the last peak of price
in profit.

Trailing Stepping, Pips

When trailing feature is actived and the price moves in the favour of the position by this amount of pips again
then the position's SL gets adjusted again. The new SL is set to be Trailing SL behind of the most recent peak
pricein profit.

For instance, assuming the following trailing settings:

1. Trailing Start at Profit = 10

2. Trailing SL =20

3. Trailing Stepping =5
When the open position reaches first time into profit by 10 pips the EA sets the position's SL to current price - 20
pips, which is actually 10 pipsin loss compared to the original entry.

When the price advances further into profit by 5 pips then the EA pullsthe SL by 5 pips, re-setting the SL to
current price - 20 pips. In other words, the SL trails the best price by steppings of 5 pips, keeping the stop loss
distance to 20 pips at each adjustment.

Dynamic Stop

Dynamic Stop Start at Profit, Pips

The EA brings progressively forward the Stop Loss of an existing position when the price moves closer to the
Take Profit of the position. Over time, the smaller the gap to the Take Profit becomes the smaller the stop behind
the current price gets used.

Tip: Watch the Expert4x Dynamic Stop video about this concept.

The EA startsto bring forward the SL of a position when the position getsinto profit by at least this Dynamic
Stop Start at Profit pips. Once the dynamic stop got activated the SL gets further brought forward every time
when the price moves on and the position gets further into profit by Dynamic Stop Stepping pips. The SL gets
recal culated to be the same distance on the stop side as the number of pips are left to reach the Take Profit level.
That is the stop gets narrower as the price gets closer to the target.

For instance, assuming the following settings:

1. Take Profit = 100 pips
2. Dynamic Stop Start at Profit = 50 pips
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3. Dynamic Stop Stepping = 10 pips

When the open position the first time goes into profit by 50 pips the EA identifies that another 50 pipsis|left to
reach the TP level. The SL gets recalculated to be that 50 pips behind the current price, i.e. break even in this
example.

When the price advances further into profit by 10 pips then the EA identifies that another 40 pipsis left to reach
the TP. The SL gets recalculated to be that 40 pips behind the current price, i.e. 10 pipsin profit from the original
entry price. Every time the price advances further and making the position into profit by another 10 pips, the EA
will move the SL tighter and reduce the size of the SL by that 10 pips.

Related information

Expertdx Dynamic Stop video

Dynamic Stop Stepping, Pips

The EA brings progressively forward the Stop Loss of an existing position when the price moves closer to the
Take Profit of the position. Over time, the smaller the gap to the Take Profit becomes the smaller the stop behind
the current price gets used.

Tip: Watch the Expert4x Dynamic Stop video about this concept.

The EA startsto bring forward the SL of a position when the position getsinto profit by at least this Dynamic
Stop Start at Profit pips. Once the dynamic stop got activated the SL gets further brought forward every time
when the price moves on and the position gets further into profit by Dynamic Stop Stepping pips. The SL gets
recalculated to be the same distance on the stop side as the number of pips are left to reach the Take Profit level.
That is the stop gets narrower as the price gets closer to the target.

For more details and example refer to Dynamic Stop Start at Profit for more details.

Related infor mation
Expertdx Dynamic Stop video

Dynamic Tar get

Dynamic Target Start at L oss, Pips

The EA pulls back the Take Profit of an existing position when the price moves closer to the Stop Loss of the
position.

Tip: Watch the Expertdx Dynamic Target video about this concept.

The EA starts off pulling back the TP of a position when the position gets into losses by at least this Dynamic

Target Start at Loss pips. Once the dynamic target got activated the TP gets further pulled back every time when
the price moves on and the position gets further into losses by Dynamic Target Stepping pips.

For instance, assuming the following settings:
1. Take Profit = 100 pips

2. Dynamic Target Start at Loss = 50 pips
3. Dynamic Target Stepping = 10 pips

When the open position the first time goes into loss by 50 pips the EA pulls back the position's TP by 50 pips.
The new TP will be the current price - 100 pips, that is +50 pips from the original entry.

When the price advances further into losses by 10 pips then the EA pulls further back the TP by 10 pips, re-
setting the TP to current price - 100 pips, that is +40 pips from the original entry. In other words, the TP trails the
latest price leading to losses by steppings of 10 pips, keeping the TP distance to 100 pips at each adjustment.

Related information
Expertdx Dynamic Target video
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Dynamic Target Stepping, Pips

The EA pulls back the Take Profit of an existing position when the price moves closer to the Stop Loss of the
position.

Tip: Watch the Expertdx Dynamic Target video about this concept.

Once the dynamic target got activated the TP gets furhter pulled back every time when the price moves on and
the position gets further into losses by this Dynamic Target Stepping pips.

For more details and example refer to Dynamic Target Start at Loss for more details.

Related infor mation
Expertdx Dynamic Target video

4.2.4 Day of Week & Time of Day Entry Filter

Expert - ? X
About  Common  Inputs  Dependencies

Variable Value 2

ab | ===="Day of Week" & Time of Day’ En... =s=s===================mm--moomec |

23] Reference Time Selection [select] Broker Server Time

|1a-3'}| GMT Offset of Broker (For GMT Time'" ... lgnore for Broker Server & PC Local Time ...

|12] Entry Window From Hour ]

|1a-3'}| Entry Window From Minute 0

|12] Entry Window Until Hour 24

|1a-3'}| Entry Window Until Minute 0

|1a-3°| Maonday Trade Ertry [select] Ertry Enabled

|1a-3n| Tuesday Trade Entry [select] Ertry Enabled

|1a-3°| Wednesday Trade Entry [select] Ertry Enabled

|1a-3n| Thursday Trade Entry [select] Ertry Enabled

|1a-3°| Friday Trade Entry [select] Ertry Enabled Load

|1a-3'}| Saturday Trade Entry [select] Entry Enabled

tad] Sunday Trade Entry [select] Entry Enabled v Save

Cancel Reset

Reference Time Selection

Reference Time Selection
Selects the nature of the time used by the EA when time specific actions are performed.

||1a-3':] Reference Time Selection [select] Broker Server Time

Broker Server Time
PC Local Time
GMT Time (Set GMT Cffset Below)

Reference

Time Selection Description

Entry window hour and minute settings are relevant to the broker's server time.

Broker Server Time See below picture showing the broker server time in the Market Watch window.
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Reference

Time Selection Description

Entry window hour and minute settings are relevant to the local time of the PC
PC Local Time hosting the MT4 terminal and EA. When setting up the time parameters consider
the time zone differences between the market open hours versus the PC local time.

Entry window hour and minute settings are relevant to the selected GMT offset.

Thisfeature is useful to keep the entry window hour and minute settings the
same when the EA is executed across different brokers. In this case only the
broker GMT offset needs to be set on the different brokers M T4 instances, and
the EA adjusts automatically the entry window for the broker.

GMT Time (Set GMT
Offset Below)

In this case, usethe GMT Offset of Broker to select the broker offset and always
set the window hour valuesin GMT +0 time zone.

GMT Offset of Broker

GMT Offset of Broker

The time zone shift of the M T4 broker's server time. This parameter is only required if GMT Time option is
selected for the Reference Time Selection.

|i2d] GMT Offset of Broker (For 'GMT Time’ Case) ... | Ignore for Broker Server & PC Local Time Cases ~

lgnore for Broker Server & PC Local Time Cases
GMT -11:00

GMT -10:00

GMT -5:00

GMT -8:00 Pacific Time (US & Canada)
GMT -7:00 Mourtain Time (LS & Canada)
GMT -6:00 Central Time (LIS & Canada)
GMT -5:00 Eastem Time (U5 & Canada)
GMT -4:00 Atlantic Time (Canada)

GMT -3:00 Brasilia

GMT -2:00

GMT -1:00

GMT +0:00 Greenwich Mean Time (London)
GMT +1:00 Central Europe (Brussels, Berin)
GMT +2:00 Eastem Europe (Athens, Tallin)
GMT +3:00 Moscow

GMT +4:00

GMT +5:00

GMT +6:00

GMT +7:00

GMT +2:00

GMT +5:00

GMT +10:00 Eastem Australia {Sydney)
GMT +11:00

GMT +12:00

GMT +13:00

GMT +14:00

Unfortunately MT4 terminal does not provide this broker GMT offset information therefore a query to the broker
maybe needed to get this value. As an alternative, one may make an attempt to cal culate this offset through the
following steps:

1. The Market Watch window's header shows the broker's server time, press Ctrl+M inthe MT4 terminal:

A | =/ #
Market Watch: 23:46:55 =
Symbol Bid Bk M
& USDCHF | 0.94233| 0.94252

& GBPUSD | 125401 1.25418

L a am—mm—=l a4 amemam

Thistime can be compared to the GMT+0 time to calculate the GMT offset of the broker.
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2. Inaweb browser search for gnt time keywords to see the current GMT time.

3. Then compare the search result of current GMT time to the current time displayed by the Market Watch
window of the MT4 terminal. The difference of the two times gives the broker GMT offset.

Based on past experience, with no guarantee that the information is correct, these are afew sample broker GMT
offsets observed as of July 2015:

MT4 Terminal Broker GMT Offset
AxiTrader AxiCorp Financial Services Pty Ltd +3
IC Markets International Capital Markets Pty Ltd +3
InstaForex InstaForex Companies Group +3
FXCM Forex Capital Markets Inc +3
ThinkForex TF Globa Markets (Aust) Pty Ltd +3
RoboForex EU RoboForex (CY) Ltd +3
Tallinex Tallinex Ltd 0
Oanda OANDA Corporation -4
MB Trading FX MB Trading Futures Inc -4

The value in the GMT Offset column could be used for the EA parameter GMT Offset of Broker.
Entry Window From Hour/Minute - Entry Window Until Hour/Minute

Entry Window From Hour/Minute - Entry Window Until Hour/Minute
Limits the period of a day when a new position entry may take place.

The From Hour & Minute isinclusive, while the Until Hour & Minute is exclusive. The following table shows
examples how to configure these parameters for the entry window period:

Desired Entry Period Entry Window From Entry Window Until
8—10 (i.e. 8:00.00-9:59.59) Hour =8 & Minute=0 Hour =10 & Minute=0
10-17 (i.e. 10:00.00-16:59.59) Hour =10 & Minute=0 Hour =17 & Minute=0
All Day Hour =0 & Minute=0 Hour =24 & Minute=0

The entry window from and until hours are specific to the selected time at Reference Time Selection.
Monday ... Sunday Trade Entry

Monday ... Sunday Trade Entry

Days allowed for new position entry. Subsequent management of stop loss or exit of already open trades may
happen outside of the enabled days, only the entry of new positionsislimited to the selected days:

I1af] Monday Trade Entry [zelect] Entry Enabled b
3] Tuesday Trade Entry [select] Mo Ent

I1aﬁ Wednesday Trade Entry [select]
I1aﬁ Thursday Trade Entry [select] Entry Enabled

Iﬁﬂ Friday Trade Entry [zelect] Entry Enabled

Iﬁﬂ Saturday Trade Entry [select] Entry Enabled

Iﬁﬂ Sunday Trade Entry [zelect] Entry Enabled

Page 26



theTradeableADX EA Configuration Guide

Day of Week Trade Entry

Description

No new entry is executed on that day.

No Entry Stop Loss management, if turned on, for existing open positions are still
executed as normal.
Entry Enabled New entry is allowed for the day when all other entry criteria are met.

4.2.5 Oper ations Settings

Expert - theTradeableADX 7 x
About Common Inputs  Dependencies
Variable Value &
|123E] Wednesday Trade Entry [dropdown] Entry Enabled
,123]}| Thursday Trade Entry [dropdown] Entry Enabled
.‘EEEI Friday Trade Entry [dropdown] Entry Enabled
|123E] Saturday Trade Entry [dropdown] Entry Enabled
,123]}| Sunday Trade Entry [dropdown] Entry Enabled
ab | ==== Operations Settings ==========soooooooooooooooooooooo Load
|123E] Tick Scaling for CFD Markets [dropdo...  Auto Scale for Index Markets
|i23] MagicNumber 191210 w Save
Cancel Feset

Tick Scaling for CFD Markets

Tick Scaling for CFD Markets

Provides a consistent tick, pip, cent and point values across various markets and brokers. Thisis specific to stock

indices, metal, commodity etc markets keeping the cent or dollar unit consistently applied. Wherever the EA
is configured with a'Pip' value then it is consistently mapped to the cent or dollar unit for those non-FOREX

markets.

| 8] Tick Scaling for CFD Markets fselect]  [Auto Scale for Index Markets

Auto Scale for Index Markets
Mever Scale
Always Scale

Tick Scaling for
CFD Markets

Description

Auto Scale for Index

Based on the characteristics of the market the EA automatically recognizesif the
underlying market was a stock index market, like the US30, GER30 or JP225

Markets etc. In this case the 'pip' values configured for the EA are scaled up to the 'dollar’
value of the index: 12345.67

Never Scale TheEA dqes not scale up the 'pip' values even if the market could be recognized
as astock index market.
The EA applies the scaling up of the 'pip’ values to the 'dollar’ value even if the

Always Scale market could not be recognized as stock index market. This option is useful if

the 'dollar’ based approach is desired for trading.

Note: The EA aways deals with the fractional pip values therefore there is no need to increase the 'pip' values
for brokerswith 1, 3 or 5-digit data feed.

Examples:
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Stop

Tick Scaling

Trading Chart of Loss EA for CFD Buy Entry g?cl)%ull_aotseg Description
Approach Market Parameter Markets Fill Price |
Value Value VG
TheEA
scalesthe
Auto Scale 100 'pips
for Index parameter
Index Markets to market
market with US30 100 . 26123.90 26023.90 .
$1.00 unit Alternative: price of
Always 100.00 US
Scale dollar units
(i.e. 100.00
points)
Auto Scale
for Index The EA
FOREX Markets keepsthe
pair with EURUSD 100 . 1.13412 1.12412 | 100 'pips
0.0001 unit Alternative: parameter
Never asitis
Scale
fAUtlo Sca'e The EA
or Index
Gold Markets rlr:)a(;):)sptlgz
market with XAUUSD 100 . 1288.23 1287.23
$0.01 unit Alternative: parameter
Never to 100 cent
Scale units
The EA
Gold Always rl?)agsptlgz
market with XAUUSD 100 1288.23 1188.23
$1.00 unit Scale parameter
to 100
dollar units
;Autlo Scale The EA
or Index
Oil market Markets rlrgjaéas t_hz
with $0.01 USOil 100 , 56.752 55.752 PIB
unit Alternative: parameter
Never to 100 cent
Scale units
The EA
Oil market Always flTE)appS”;ze
with $1.00 USQil 10 56.752 46.752
unit Scale parameter
to 10 dollar
units
;Autlo jcale The EA
or Index
Copper Markets rlnoagsptlgz
market with COPPER 100 . 2.9245 1.9245
$0.01 unit Alternative: parameter
Never to 100 cent
Scale units




Stop Tick Scaling calculated
Trading Chart of Loss EA for CFD Buy Entry Stop Loss Description
Approach Market Parameter Markets Fill Price Vglue P
Value Value
Auto Scale The EA
for Index maps the
Cocoa Markets 100 'pips’
market with COCOA 100 . 2160 2060
$0.01 unit Alternative: parameter
’ Never to 100 cent
Scale units
fA“tIO jca'e The EA
or Index
Natural gas Markets rlrz)aéasptlgz
market with NGAS 100 . 2.843 1.843
$0.01 unit Alternative: parameter
' Never to 100 cent
Scale units
Magic Number
Magic Number

The EA marksits orders with this value when submitting to the broker account, and picks up orders which are
marked with this magic number value and belong to the chart of the EA. In the case of multiple EA's running on
the same market ensure that they get unique Magic Number allocations to avoid cross-impact between the EA

instances handling the orders. See Configuration and Operation Principles section for more explanation and setup

examples.

Related information
Configuration and Operation Principles

The theTradeableADX EA operational overview.

theTradeableADX EA Configuration Guide
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5

Knowledgebase

Frequently Asked Questions and other common use cases.

5.1 How to Download M T4

Question
How can | install the MT4 platform?

I checked the MetaQuotes site and it looks like | can only download the MT5 platform.

Answer

Theway to get and install MT4 isto download it directly from your broker.

Please download the M T4 setup application directly from one of your preferred brokers web site.

5.2 How to Download the Setup Application

Question
How to download the theTradeableADX EA Setup application?

1. Logintothe Web Support Centre.

*» Web Support Centre x +
&« C &* https://my.eafactory.com/expertdx
Login

Login

Login name recovery

Password recovery

Services powered by EAfactory.com - Copyright © 2008-2020 EAfactory.com -
v4.5.0

Expert4x

Login name :  Login name

Password :  Password

Terms and Conditions  Privacy Policy

3

2. Scroll down and click on the theTradeableADX EA in the Product List.
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Product List

EXP ertdx theTradeableADX l

- - - o

3. Click on the Product Download button to download the EA setup.

Release List

theTradeableADX MT5 v | Users Guide || Product Download |

theTradeableADX MT4 v | Users Guide || Product Download |

5.3How to Install thetheTradeableADX EA

The theTradeableADX EA comes with a setup application to provide a wizard based installation process to the

selected MT4 terminal.

Beforeyou start...

A w DN

Ensure that you have the login credentials to the Web Support Centre.
Ensure that you have an MT4 terminal version 4.00 build 1320 or later installed.

Exit MT4 if it was running.
Select the desired service and download the setup application with the latest version.

Run the setup application. Select the M T4 instance during setup to where you want the service installed.

When setup completes start up MT4. The theTradeableADX EA entry should appear under the Expert
Advisors node in the Navigator window (View > Navigator)

These pictures highlight the steps how to install the EA.

ﬁ%’ Setup - theTradeableADX MT4 EA — >

Welcome to the theTradeableADX
MT4 EA Setup Wizard

This will install theTradeableADY, MT4 EA version an yaour
computer.

Itis recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.
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ﬁ%‘ Setup - theTradeableADX MT4 EA -

Select Target MetaTrader Directory
Far which MT4 location should theTradeableADX EA be installed?

Setup will install the theTradeableADX EA under the selected MT4 instance.

(O c:'\Program Files (x86)\MetaTrader 4 IC Markets's Data Folder A
() C:VProgram Files (x86)\ThinkForex Australia MetaTrader 4's Data Folder

() C:\Program Files (x36)\OANDA MetaTrader's Data Folder

() C:VProgram Files (x36)\MetaTrader 4's Data Folder

(O) CiVProgram Files (x86)\Tallnex MetaTrader 4 - 01's Data Folder

(O) Ci\Program Files (x86)\MetaTrader 4 FinF¥'s Data Folder

C:\Program Files (x86)\Blueberry Markets MetaTrader 4 Terminal's Data
o Folder

(0) C:¥Program Files (x86)\MetaTrader - RoboForex's Data Folder

(O ¢:\Program Files (x86)\Tallinex MetaTrader 4 - 02 - mg's Data Folder

(O) c:\Program Files (x86)\MetaTrader - AxiTrader's Data Folder

() C:VProgram Files (x86)\MetaTrader's Data Folder

~ C:\Proaram Files (x36)\Blugberrv Markets MetaTrader 4 Terminal - ud's Data ¥

< Back Next = Cancel

The setup application lists the available M T4 instances. Select one of them for installation target and click on the
Next.

Note:

For some earlier version Windows version the list may not contain all the MT4 instances. In this case use the
Add target directory... button to navigate and pick up the desired folder.

ﬁ! Browse For Folder X
Select Ta
For whig Select a MT4 target folder in the list below, then dick OK
Setup w w MetaTrader ~ nstance,
Oc config
(@)X history er
O c MOL4
8 g profiles
@] C Sounds
O c templates
Oc MetaTrader - AxiTrader
MetaTrader - RoboForex
MetaTrader 4 FinFX
MetaTrader 4 1C Markets N
< > |ctory.
Cancel
Cancel

C:\ Program Fi | es\ Br oker Speci fi cNane\

but you may have selected something else while performing the MetaTrader installation. As a hint, the following
shows you the default path to the main M T4 directory for some brokers:

Broker Default Path
Blueberry Markets broker C:\Program Files (x86)\Blueberry Markets MetaTrader 4 Terminal
Dukascopy broker C:\Program Files (x86)\Dukascopy MetaTrader 4
|G broker C:\Program Files (x86)\IG MetaTrader 4 Terminal
OANDA broker C:\Program Files (x86)\OANDA - MetaTrader
Pepperstone broker C:\Program Files (x86)\Pepperstone MetaTrader 4

Always select the main MT4 folder itself for installation target, not any of its sub-directories.
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Select Start Menu Folder
Where should Setup place the program's shaortcuts?

o
Setup will create the program's shortcuts in the following Start Menu folder.
[—=-]

To continue, dick Next. If you would like to select a different folder, dick Browse.

| | Browse...

- Expertdx

| <Back [ MNext> | | cancel |

Knowledgebase

When the installation is complete, start up MT4 and check that the EA appearsin the Navigator window (View >

Navigator):

B 19974105: Eightcap-Demo - Demo Account - m} s
File View Tools Help

G- B [f 0 OB @Nwona & B @ [@Avoteang [ 1 £ [Q & B[t O- 2] » O

’T -- | | = 7 # # a4 F o%- ML M5 IS MBOIT He DL w1 Mn
Navigator
BBM MT4
8 Accounts
Indicators
: Expert Advisors
€8 MACD Sample
5 Moving Average
% theTradeableADX

Common | Favorites |

For Help, press F1 | Default | | | | | | | Wil 2141 kb

So everything is set up for the first activation of the theTradeableADX Expert Advisor .

5.4 How to Upgradethe EA

Question
How to upgrade the theTradeableADX EA?

Answer
In order to upgrade the EA please follow these steps:

1. Download the latest theTradeableADX EA from the Web Support Centre. For detailed steps refer to the

How to Download the Setup Application.
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2. Exit the MT4 terminal if it was running.

3. Execute the downloaded theTradeableADX EA setup application. Follow through all of the wizard pagesto
complete the EA installation.

4, Start up the MT4 terminal.

The upgraded theTradeableADX EA will pick up and carry on managing any existing trades created by the
previous EA version.

Related tasks

Step-by-step Installation of Expertdx EAs and Indicators

How to download an EA setup in VPS environment

Related information

How to Download the Setup Application

5.5 How to Attach thetheTradeableADX Expert Advisor toa Chart

Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the theTradeableADX Expert Advisor in afew
steps.
Attach the EA to achart

1. Drag & drop the theTradeableADX Expert Advisor from the Navigator window (View > Navigator) to a
chart window and select the Common tab:

227 ¢ O B GNewodsr & B @ [@ruoTadng[[11 1 1 |@ @ B[b 1 |G- O- B » O
Kk -1 = 7 13}: e Hi % v I ML M5 MIS MI0 | HT H4 DI W1 MN
Market Watch: 16:33:33 X ||+ EurRuSD,HL 1.20855 1.20689 1.20624 1.20647 theTradesbleADX (D)
Symbal Bid Ask 132235
& USDCHF 0.89133 0.89144 l[”m‘
1.220%0
% GBPUSD 1.35470|  1.35489 |HH |
¥ EURUSD 120847 | Eypert - theTradeableADX ? X 121955
% USDIPY 103.730
£ USDCAD 127713 About  Commen Inputs  Dependencies 1.21825
% AUDUSD 0.75725 Comman Safety \aes0
4 EURGEP 085047
~ iti Alow DLL It
Symbols | Tick Chart | LTyl S postions B4 Alow mports 121555
e = Enable alerts AMllow import of extemal experts
| o y ; 1.2142%
. BEBM MT4 [ Disable lert ance hit [ Mllow madification of Signals settings
@ Accounts 121990
-] Indicators Live Trading
E‘ % Expert Advisors [+ Allow live trading 121155
{148 MACD Sample
% Maoving Average 121025
%8 theTradeableADX
[ Seripts Cancel Resat 1.20850
INUHP W“l ‘ 1,20755
o T T T T T T T 120450
Common | Favorites 11Jan 2021 123en 05:00 12Jan 2000 13Jan 1300 14 Jan 05:00 14 Jan21:00 15Jen 13:00 18 Jan 05:00
For Help, press F1 Default WEGili 17171 kb
Note:
Ensure that the

* Allow livetrading,
e AllowDLL import and
* Allowimport of external experts

areticked.

2. Select the Inputstab:

Page 34



Knowledgebase

e
B D [[F ¢ G B B GNvoder & B o [Grvoman [ 1 1 [@ @ B[k |G- O-2- » O
k- | - 7 1955 EOOA W % v DML OME WIS M3 HL He DL Wi MM
Market Watch: 15:46:26 % ||+ EURUSD.HL 1.21255 121406 1.21235 1.713%4 theTradeabl=ADX (©)
Symbol Bid sk ™ 122225
¥ USDCHF 0.88653 0.88663 ll“m‘
1.72050
% GBPUSD 1.36153|  1.36171 HHI |
i EURLISD 121384 | Expert - theTradeableADX T X La1sss
4 USDIPY 103.872
4 USDCAD 1.27302 About  Common Inputs  Dependencies 1.21825
77
& AUDUSD 077188 Variable Value 2 121630
4 EURGEP 0.89151
Symbols | Tick Chart | ab| ==== ADX Indicator Settings 121558
= pa‘:ﬂ Entry Method [dropdown] ADX Trend & Direction
Mavigator
"_'QSBM v A |[#3] ADX Period [>=2] 12 R
W A ] ADX Level [>=0] 25
ccounts _ 1.31280
[#) Indicators pa‘!‘j Trend Following Method [dropdown] Start of Trend: One Entry
% Expert Advisors pz‘:ﬁ Posttion Action upen Trend Change [dr... Close All Previous Trend's Positions Load 121158
‘% MACD Sample ,@Eﬁ Postion Action upon ADX Decline [dro... | Keep All Posttions Open
% Moving Average ab | ====Common Settings W Save 121025
2 theTradeableADX
.25 Scripts Cancel Reset 120830
L T
l‘ l.l 1.20625
B T T T T T T T 1.20420
Common | Favorites 123en 2021 13Jen 0K00 13 J2n 20:00 14 Jen 12:00 15 Jen 0400 15J2n20:00 18 Jan 12:00 19 Jan 000
For Help, press F1 Default il 63070 kb

Thislists the parameters of the EA where the operational aspect of the theTradeableADX EA can be set up.

For more details see the theTradeableADX EA Configuration Guide —for now click on the OK button and

let the EA start
Note:

up with default settings.

At the very first time the EA may prompt for the Access ID to verify that the usage of product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support site. Feel freeto
change your Access ID at the Web Support Centre and ensure not to share it with anyone else. Enter the

Access ID and

click on the Save button:

Unknown Access 0. Please enter

!"-.

Product :

Provider:

valid Access 1D,

Access |D:

Dialog closesin Z2min 2 seconds

ThetheTradeableADX EA isup and running
After successful authentication the theTradeableADX EA starts up.
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5.6

Cﬁ 19962789 Eightcap-Demeo - Demo Account - [EURUSD,H1] O X
File  View Inset Charts Tools Window Help -8 %
%@Yv = P__‘_'J\||%_New0rder & B g |@AutoTradingEH‘ 18 J/_\.|@% =) EH— yol ,_o
k—:—|| - 7 @ A ?f,vér\-n WS MIS M30 | H1 H4 DL WIMN‘
Market Watch: 15:51:36 * ||+ EURUSD,HL 1.21255 1.721409 1,21279 1.21384 theTradeableADX () [ 1.22290
Symbol Bid Aske ™
theTradeableADX v1.0.0 1.33150
& USDCHF | 0.88691| 0.38703 ’
o GBPUSD | 1.36147 136163 ER) (Floafing) (Acunt) [Wakel) Exection I
4 EURUSD | 1.21334| 1.213%4 theTradeableADX v1.0.0 on EURLSD H1 wimagic 191210
& UsDIPY 103.292| 103.905 Status: Enabled Access: 512878483-1-0-0@13:49:20 Licensed until: unlimited 171950
@ USD.. | 1.27310] 127327 - B Infe
p— P—— Stage - Monitoring Entry 1.21890
# AUD... 0.77158) 0.77172 Active - Buy: 0 Sell:0 = Total:0 cut of 5 Max
4 EURGBP | D.29143| 0.89162 Setup - ADX(12) Trend+Diraction
Setup - Pos:Close All; ADX:Keep All; Trend:One Entry 121730
4 EURAUD | 157301 1.57321 Filter - Spread:<=5pips Days:Su Mo Tu'We Th Fr Sa Time:0:00 - 24:00
& EURCHF | 1.07658 1.07674 Risk - Manual 0.01 lots; InitSL:120pips; Bresk'e:50 lodk:230pips; TP:120pips 1.21650
Trailing - Start:60 Stop:40 Step:10pips
4 EURIPY | 126.114| 126.125 Dynamic- Target Start:50 Step:10pips: Stop Start50 Step:10pips
& GBPCHF | 120757/ 120788 \ Spread - 1.0 Gurent vs 5.0 pips Limit = 20% into suspension 1.21550
W
AN Trading Overview
Symbols | Tick Chart | r\r:-sd::e: l:c::sc- far L21430
MNavigator ®
— Floating Profit and Loss
BEM MT4 ‘e
i Buy Crders - Count:0 Lots:0.00 P&L Pips:0.0 USD:0.00 C&Swap:0.00
El& Accounts Sell Orders - Count:0 Lots:0.00 P&L Pips:0.0 USD:0.00 C&Swsap:0.00 ‘ 1.21250
= i-ﬁ Eightcap-Demo Total Floating - Count:0 Lots:0.00 P&L Pips:0.0 WSD:0.00 C&Swap:0.00
o (b 19906725 Demao A 121190
— Account Level Info
£} 19962788: Demo A
F Indicat Margin:0.00 Free Margin%:100.00 Margin Call 8t:50% Leverage: 100 121050
-2 Indicators Balance:10000.00 Equity:10000.00 PAL USD:0.00 Equity%:100.00
-8 Expert Advisors
.2 MACD Sample — Market Info |} ] L.20%50
-8 Moving Average Spread - Cument: 1.0 Avg:1.0 Max:1.1 at Server Time:2021.01.19 15:49:58 * [
.. € theTradeableADX Lot - Size: 100K Min:0.01 Step:0.01 Margin req:1212.94 Pip value:USD 10.00 1.20530
B- Scripts — Executicn Info 1.20730
Time - Server:2021.01.19 15:51:33 Local:2021.01.19 13:51:23
Broker - Bluebemy Markets Pty Ltd on server Eightcap-Demao 1.20650
Profile - Previcus Duraticn{ms):0 Average:0.31 Max:18 Count:104
1.20550
I H
5 T T T T T T T 1'204”
Common | Favorites 12320 2021 13 Jan OL:00 13 Jan 17:00 14 Jan 09:00 15 Jan OL:OD 15 Jan 17:00 18 Jan©9:00 19 Jan 0L:00
For Help, press F1 | Default | | | | | | | A

Knowledgebase

The theTradeableADX Expert Advisor has been attached to the chart. The smiley face in the top-right corner
shows that the initialisation of the theTradeableADX Expert Advisor was successful and the EA is now looking

for trading opportunities.

See the smiley face in the corner:

=)

I theTradezbleA DX ) I

122750

In case of a problem getting the EA up and running please refer to the Knowledgebase section.

How to L oad Setfile from the Settings Analysis Site

In this topic we guide you through how to download the EA settings from the Settings Analysis page, and load

those settings into the EA in the M T4 application.

1. First, download the set file: Go to the Settings Analysis page.
2. Click on the analysis type, FOREX or INDEX markets, for which you want to get the set file. For instance,

click on the Comprehensive analysis: Details link on the Settings Analysis page.
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3. Right-click on the MT4 ® sign and select Save link as...

Leverage Timeframe %
100 H1
100 H1
100 H1
100 H1
100 H1

Symbol 3 | Spread Set File§| Pass%
AUDJPY 3.0 MT4@ vem 2793
Cpen link in new tab
AUDUSD 3.0 MT4 G Open link in new window
Cpen link in incognito window
EURAUD 40 MT4@
Save link as...
EURJPY 3.0 MT4@ Capy link adh
EURUSD 3.0 MT4Q  jnspect

Model

Ctrl+Shift+

'y
v

Coaembenl O TiAl

4, Click on Downloadsin the Quick accesslist then click on the Save button:

€ savehs X
« v ; » ThisPC » Downloads v O £ Search Downloads
Organise « Mew folder EEE 0
[ Desktop -+ Mame Date modified Type
* Downloads*__.—
~ Mo iterns match your search.
= Documents o
=] Pictures -
v £ >
File name: | theTradeableADX MT4 w
Save as typer | SET File (*.5et) w
~ Hide Folders Cancel

5. Now load the set file into your EA on an M T4 chart: Attach the EA to anew or existing chart.

6. Click onthe L oad button:

Expert - theTradeableADX

About  Common  Inputs

Dependencies

Variable
ab | ==== ADX Indicator Settings
|1z Entry Method [dropdown]
[ied] ADX Period [>=2]
[ied] ADX Level [>=0]
I.L%j Trend Following Method [dropdown]

ab | ====Common Settings

I.L%j Position Action upon Trend Change [dr...
u{sj Posttion Action upon ADX Decline [dro...

ADX Trend & Direction

12

25

Start of Trend: One Entry

Close All Previous Trend’s Positions
Keep Al Postions Open

oK

? x
~
Load
v Save
Cancel Reset

7. Click onthe Downloads in the Quick access list then double-click on the set file:

Knowledgebase
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v 3 Quick access

= Documents
L B 4

= Dirturec

[ Desktop // Today (1) /
- Downloads [ theTradeableADX MT4

Ce Open
« v A ; » ThisPC » Downloads v | 0 Search Downloads
Organise « Mew folder == -

-
Date modified

File name: | *.set

- | Expert Set (*.set)

o @

Type

SETH

8. Thisloads the settings from the set file into the EA parameters. Click on the OK button:

Expert - theTradeableADX

fbout Common Inputs  Dependencies

Wariable
ab | ==== ADX Indicator Settings
|i2d] Entry Method [dropdown]
|izd) ADX Period [>=2]
|1ed] ADX Level [>=0]
||a—3'j Trend Following Method [dropdown]
||z_3‘j Position Action upon Trend Change [dr..
|1!_3‘j Position Action upon ADX Decline [dro...

ab | ==== Common Settings

ADX Trend & Level & Direction
40
10
With the Trend: Multiple Entry

?

Close All Previous Trend’s Positions
Load

Keep All Positions Open

] Save

Reset

*

5.7 MetaViewer dll could not be found

Knowledgebase

I ssue

After the EA setup application finished the following error message was popped up:
Therewas a problem starting C:\Windows\system32\M etaViewer .dll The specified module could not be

found.

Therewas a problem starting C:\Windows\system32\M etaViewer 64.dll The specified module could not be

found.

Q

Errar loading C:\WINDOWS| svskem32 MetaViewer . dll

The specified module could naot be found.

Solution

From the EA installation perspective you can ignore this message.

Theinstaller was at the very last step to start up the Users Manual PDF viewer. Thisis arequest to the Windows
operating system to start the registered PDF reader application and looks like Windows could not start up the
PDF reader for some reason. Thisis probably a Windows or an M T4 settings problem.
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Please double check that the EA appearsin the MT4 terminal Navigator window (press Ctrl+N), it should be
listed at the section Expert Advisors.

5.8theTradeableADX Expert Advisor First Time Activation

Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the theTradeableADX Expert Advisor in afew
steps.
Attach the EA to achart

1. Drag & drop thetheTradeableADX Expert Advisor from the Navigator window (View > Navigator) to a
chart window and select the Common tab:

F- 28 ¢ O 8| GNwoder & B @ [@AvoTedng [ 18 [ @ B[]l |G- O-B- » O
A -1 — / # E A H %M oM omis M3 H H4 DLWl oMN
Market Watch: 16:33:33 X ||+ EURUSD.Hi 1.20656 1,20659 1.20624 1,20647 theTradasbleADX @)
Symbol Bid Ask 122225
2 USDCHF 0.89133 0.89144 ll”m‘ 122050
% GBPUSD 1.35470  1.35489 |HH |
g EURLISD 120847 | Expert - theTradeableADX 70X 121855
¥ USDIPY 103.730
4 USDCAD 1277113 About  Common  |nputs  Dependencies L2828
% AUDUSD 0.76785 Common Safety -
4 EURGEP 085047
i Allow DLL imports
Symbols | Tick Chart | Cougs o S| postons = P 1.21555
e = Enable alerts AMlow import of extemal experts
8 P ] ) 121425
: | BEM MT4 [] Disable lert once hit [ Allow madification of Signals settings
@ Accounts 1,71250
7] Indicators Live Trading
Expert Advisors Allow live trading 121155
22 MACD Sample
22 Moving Average 1.21025
2 theTradeableADX
- Sy Scripts Cancel Resst 120850
.ull‘.{l mi “l ‘ 1.20755
B T T T T T T T 120450
v = 11Jen 2021 122200500 12 Jen 2100 13 Jan 1300 14 Jan 0500 14 Jen 2100 15 Jan 13:00 18 Jan 0500
Common | Favorites
For Help, press F1 Default i 17141 kb
Note:
Ensure that the

» Allow livetrading,
» AllowDLL import and
e Allowimport of external experts

areticked.

2. Select the Inputstab:
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e
B D [[F ¢ G B B GNvoder & B o [Grvoman [ 1 1 [@ @ B[k |G- O-2- » O
k- | - 7 1955 EOOA W % v DML OME WIS M3 HL He DL Wi MM
Market Watch: 15:46:26 % ||+ EURUSD.HL 1.21255 121406 1.21235 1.713%4 theTradeabl=ADX (©)
Symbol Bid sk ™ 122225
¥ USDCHF 0.88653 0.88663 ll“m‘
1.72050
% GBPUSD 1.36153|  1.36171 HHI |
i EURLISD 121384 | Expert - theTradeableADX T X La1sss
4 USDIPY 103.872
4 USDCAD 1.27302 About  Common Inputs  Dependencies 1.21825
77
& AUDUSD 077188 Variable Value 2 121630
4 EURGEP 0.89151
Symbols | Tick Chart | ab| ==== ADX Indicator Settings 121558
= pa‘:ﬂ Entry Method [dropdown] ADX Trend & Direction
Mavigator
"_'QSBM v A |[#3] ADX Period [>=2] 12 R
W A ] ADX Level [>=0] 25
ccounts _ 1.31280
[#) Indicators pa‘!‘j Trend Following Method [dropdown] Start of Trend: One Entry
% Expert Advisors pz‘:ﬁ Posttion Action upen Trend Change [dr... Close All Previous Trend's Positions Load 121158
‘% MACD Sample ,@Eﬁ Postion Action upon ADX Decline [dro... | Keep All Posttions Open
% Moving Average ab | ====Common Settings W Save 121025
2 theTradeableADX
.25 Scripts Cancel Reset 120830
L T
l‘ l.l 1.20625
B T T T T T T T 1.20420
Common | Favorites 123en 2021 13Jen 0K00 13 J2n 20:00 14 Jen 12:00 15 Jen 0400 15J2n20:00 18 Jan 12:00 19 Jan 000
For Help, press F1 Default il 63070 kb

Thislists the parameters of the EA where the operational aspect of the theTradeableADX EA can be set up.

For more details see the theTradeableADX EA Configuration Guide —for now click on the OK button and

let the EA start
Note:

up with default settings.

At the very first time the EA may prompt for the Access ID to verify that the usage of product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support site. Feel freeto
change your Access ID at the Web Support Centre and ensure not to share it with anyone else. Enter the

Access ID and

click on the Save button:

Unknown Access 0. Please enter

!"-.

Product :

Provider:

valid Access 1D,

Access |D:

Dialog closesin Z2min 2 seconds

ThetheTradeableADX EA isup and running
After successful authentication the theTradeableADX EA starts up.
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o} 19962729: Eightcap-Demo - Demo Account - [EURUSD,H1] - | X

File  View Inset Charts Tools Window Help -8 %

B D[R ¢ O E | Ghvoder § B (9 [GrnoTadng|[ 1z 9 | @ @ FH| » O
k—}—|| - 7 @ A M1 M5 MIS M30 | HL H4 Dt WIMN‘
Market Watch: 15:51:36 % |[+ EURUSD,HL 1.21755 1.21409 1.71779 1.71384 theTradesbleA DX () [ 1.22250
Symbol Bid Aske ™
theTradeableADX v1.0.0 3 1.27130
@ USDCHF | 0.88691 0.88703 !
o GBPUSD | 1.36147 136163 EA  Floating nt, Maket| Execstion )
4 EURUSD | 1.21334| 1.213%4 theTradeableADX v1.0.0 on EURLSD H1 wimagic 191210
& UsDIPY 103.292| 103.905 Status: Enabled Access: 512878483-1-0-0@13:49:20 Licensed until: unlimited 171950
@ USD.. | 1.27310] 127327 [ B Infa
—_— P Stage - Monitoring Entry 121850
# AUD... 0.77158) 0.77172 Active - Buy: 0 Sell:0 = Total:0 cut of 5 Max
4 EURGEP 0.89149 0.89162 Setup - ADX[12) Trend+Direction
Setup - Pos:Close All; ADX:Keep All; Trend:One Entry 121730
4 EURAUD | 157301 1.57321 Filter - Spread:<=5pips Days:Su Mo Tu'We Th Fr Sa Time:0:00 - 24:00
& EURCHF | 1.07658 1.07674 Risk - Manual 0.01 lots; InitSL:120pips; Bresk'e:50 lodk:230pips; TP:120pips 1.21650
Trailing - Start:60 Stop:40 Step:10pips
4 EURIPY | 126.114| 126.125 Dynamic- Target Start:50 Step:10pips: Stop Start50 Step:10pips
& GBPCHF | 120757/ 120788 \ Spread - 1.0 Gurent vs 5.0 pips Limit = 20% into suspension 1.21550
W
e AN Trading O fiew
Symbols | Tick Chart | r\r:-ad::ec :;nc::':c- far L21430
MNavigator ® - -
BEM T4 — Floating Profit and Loss
i Buy Crders - Count:0 Lots:0.00 P&L Pips:0.0 USD:0.00 C&Swap:0.00
B@J Accounts Sell Orders - Count:0 Lots:0.00 P&L Pips:0.0 USD:0.00 C&Swsap:0.00 ‘ 1.21250
= ﬁ Eightcap-Demo Total Floating - Count:0 Lots:0.00 P&L Pips:0.0 WSD:0.00 C&Swap:0.00
- &b 19906725: Demo A 121150
3 19962728: Demo A — Account Level Info
F Indicat Margin:0.00 Free Margin%:100.00 Margin Call 8t:50% Leverage: 100 121050
-2 Indicators Balance:10000.00 Equity:10000.00 PAL USD:0.00 Equity%:100.00
-8 Expert Advisors
2 MACD Sample — Market Info |} ] L.20%50
2 Moving Average Spread - Cument: 1.0 Avg:1.0 Max:1.1 at Server Time:2021.01.19 15:49:58 “ [
€ theTradeableADX Lot - Size: 100K Min:0.01 Step:0.01 Margin req:1212.84 Pip vslue:USD 10.00 1.20830
B- Scripts — Executicn Info 1.20730
Time - Server:2021.01.19 15:51:33 Local: 2021.01.19 13:51:33
Broker - Bluebemy Markets Pty Ltd on server Eightcap-Demao 1.20650
Profile - Previcus Duraticn{ms):0 Average:0.31 Max:18 Count:104
1.20530
I H
5 T T T T T T T ].-me
Common | Favorites 12320 2021 13 Jan OL:00 13 Jan 17:00 14 Jan 09:00 15 Jan OL:OD 15 Jan 17:00 18 Jan©9:00 19 Jan 0L:00
For Help, press F1 | Default | | | | | | | A

The theTradeableADX Expert Advisor has been attached to the chart. The smiley face in the top-right corner
shows that the initialisation of the theTradeableADX Expert Advisor was successful and the EA is now looking
for trading opportunities.

See the smiley face in the corner:

=)

I theTradezbleA DX ) I

122750

In case of a problem getting the EA up and running please refer to the Knowledgebase section.

5.9 Sad Face Instead of Smiley Face After Attach

Issue
After attaching to chart the EA is not managing trades, a sad face appears in the top right corner of the chart.
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=

(o) & ]

() Hi17445

F1.17210

EA's common parameter s might be not enabled
The Allow live trading, Allow DLL importsand Allow import of external experts might be not enabled

* PressF7 key and verify that the Allow live trading, Allow DLL imports and Allow import of external
experts are checked in the EA property dialog.

Expert - ? *

About Commeon  nputs  Dependencies

Comman Safety
Long & Shot ~ ~ | postions Allow DLL imparts
Enable alerts Allow import of extemal experts
[] Disable alert once hit [ Allow modfication of Signals settings
Live Trading

I [+] Alow live trading I

Cancel Reset

Autotrading isdisabled
The AutoTrading might be disabled
» Verify that the toolbar button AutoTrading is pressed.
Toolbar button when Expert Advisors disabled:

ks Tools  Window  Help

G %Nmﬂrder & ©gAutoTrading 5|11 6} | @& Q. & [[[x 1k |

S A T %ML OME MIS M0 | HI M4 D1 Wil MM

w Ar et e+ rmmme o bmm e s mmm— e e mm———

Click to enable:

its Tools  Window  Help

] [ @Nmﬂrder & |G8 AutoTrading || 11 |8 } (B Q & ([[n Lk ||

SR T %ew DML ME MIS M3 [ H1 O H4 D1 Wl MM

5.10 What isthe L everage of My Account

Question
What isthe leverage of my MT4 broker account?

| am logged in to my demo or live MT4 account and want to know the leverage available on the account.

Page 42



Knowledgebase

Answer

The theTradeableADX EA displaysthe M T4 account leverage on its dashboard, at the section Account L evel
I nfo.

See the reported leverage value at the end of the first line:

Margin:0.00 Free Margin:100.00 Margin Call at:50%] Leverage:300
Balance:10000.00 Equity:10000.00 P&L USD:0.00 Equity®:100.00

In the above picture the leverage is reported as 400, which represents 400:1 account leverage.

5.11 How to Figure Out My Broker'sGM T Offset?

The MT4 platform presents its chart using the time of its broker server. The various brokers configure their server
time according to their own choice, many of them are in one of the European timezone ranging from GMT+0

to GMT+3, but some brokers opt to have their server in the US Estern timezone, which is GMT-5. These GMT
offsets may get further adjusted for the daylight savings from March till October of every year.

The theTradeableADX EA uses the time for trading decisions therefore its time input parameters need to be
adjusted by the GMT offset of the broker's server. This article describes how to figure out the GMT offset
specific to the MT4 broker account.

1. The Market Watch window's header shows the broker's server time, press Ctrl+M in the MT4 terminal:

N L -

Market Watch: 23:46:55 x
Symbol Bid Agk ™
F USDICHF | 0.94233| 0.94252

# GBPUSD | 1.23401 1.253418

- e a g me———— 3

This time can be compared to the GMT+0 time to calculate the GMT offset of the broker, as per the next
step.
2. Inaweb browser search for gmt time keywords to see the current GMT time.

3. Calculate now the broker GMT offset = 'Market Wacth time' - 'GMT time'.

For an example, assuming the following:

*  Market Watch time; 18:29
e GMT time as per the search result: 15:29

Then the calculated GMT offset is 18:29 - 15:29 = 3:00 hours. In practice - in the limited context of the forex
broker servers - it is sufficient to calculate the difference between the hour parts: 18 - 15 = 3 hours.

Note: For broker serverslocated in Europe the GMT offset islikely to bein therange of 0 and 3, i.e. azero or
positive number. For broker serverslocated in the USthe GMT offset might be in therange of -5and -6, i.e. a
negative number. Keep in mind that these figures may get further adjusted by the daylight savings.

Based on past experience, with no guarantee that the information is correct, these are afew sample broker GMT
offsets observed as of July 2015:

MT4 Terminal Broker GMT Offset
AxiTrader AxiCorp Financial Services Pty Ltd +3
IC Markets International Capital Markets Pty Ltd +3
InstaForex InstaForex Companies Group +3
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MT4 Terminal Broker GMT Offset
FXCM Forex Capital Markets Inc +3
ThinkForex TF Global Markets (Aust) Pty Ltd +3
RoboForex EU RoboForex (CY) Ltd +3
Tallinex Tallinex Ltd 0
Oanda OANDA Corporation -4
MB Trading FX MB Trading Futures Inc -4

5.12 EA IsNot Starting Up After Attach to Chart

Issue
The EA reports successful initialisation and advises about disabled Expert Advisors.

EURUSD,H1

w EURUSD,HI 1.06%1% 1.07451 1.06%00 1.07332

1.12070

Hl EA Account Market Execution

Autotrading isdisabled
The AutoTrading might be disabled
» Verify that the toolbar button AutoTrading is pressed.
Toolbar button when Expert Advisors disabled:

1.11810

its Tools  Window  Help

E . | [k New Order £ € AutoTrading IE 19 | @ < = ”E 1k | |

M1 M5 MIS M3EI|H1 H4 D1 wrl MM

= oA H %e-

Click to enable:

its Tools  Window  Help

E #) | %New[}rder & |@AutﬂTrading

Ee AT v

L nl@ e @ k|

M1 ME PMIE M20 | HI O H4 D1 Wl MM

w AT e e hmmme e e s mmm— e e =

5.13 No Updatesto Chart

Issue
The theTradeableADX EA does not update information on the chart for several minutes.

Connection L ost
MetaTrader should be connected to the broker's server.
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1. Check the bottom right corner of MetaTrader, thisiswhen it has lost connection to the server:

T ]
i Me connection

2. If connection islost then login again or restart M T to force reconnection. Try again activating the
theTradeableADX EA when connection is back.

Demo account isexpired

MT4 will not be able to connect to the demo account if it's expired. In this case MT4 will keep asking for the
login details and fail all login attempt.

* When this happens open a new demo account (right click Accountsin Navigator window and select Open
an Account).

Navigator x
BEM MT4

RS A ccouy

-/ #] Indica

% Expert

- Seript

m
]

Open an Account Insert

[}
Lo

P pry

T

Legin to Trade Account Enter
Legin to Web Trader
Legin to MOL3.community

|-

I @ 8§

'S Register a Virtual Server
I

Market is closed
New tick information and updates to chart happens when markets are open.

» Double check that markets are meant to be open currently.

Disk isfull
There should be at |east 50MB free disk space available on the drive MetaTrader isinstalled on.

» If thefree disk spaceislow then free up space.

5.14 Prompted for Access|D at Service Access Settings

Issue
After attaching to chart the theTradeableADX EA asks for my Access ID in the Service Access Settings window.

Typein your Access|D

The theTradeableADX EA checks that the usage of product is appropriately licensed. After product purchase a
user profileis created on our web support site and the product can be downloaded from that web site. The support
site allows to set up an Access ID which isrequired by the theTradeableADX EA to validate the product licence.
By default this Access ID is configured to be the same as your selected login name to the web support site.

*  When prompted, please enter your Access ID to the window and click Save:
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Unknown Access |D. Please enter
l k valid Access 1D,

Product:

Provider:

Access |-

Save Cancel

Diglog closesin  2min 2 seconds

Please do not share out to others your Access ID. That is against the licence agreement terms and
conditions and aso all 3rd party usages will count when checking the number of EA copies being used.
Sharing out your Access ID can result in licence check failure and the EA may stop functioning.

Keep your Access ID secure, change it away from the its default value at any time on the Web Support
Centre site.

5.15 How to Edit the EA Input Values

Question
How can | edit or change the settings of the theTradeableADX EA onceit is attached to a chart?

Answer

In order to edit the input parameters of an EA which is aready attached to a chart follow these steps

1. Select/click the chart which hosts the theTradeableADX EA inyour MT4 application.

2. PressF7 on your keyboard, or alternatively click on the smiley (or sad) icon in the top-right corner of the
chart.

3. Edit the theTradeableADX EA input valuesin the appearing EA properties window
4. Click OK when editing is complete

5.16 Not Enough Memory For Bar History Or Indicator

Issue

Some of the market bar history data or an indicator fails to load because the MT4 runs out of memory. An error
message similar to the below is reported:

ERROR 85120:R5] indicator failed to load orfit in memony.

At Broker Time:2013.03.02 21:59:50 Local Time:2012.0Z2.04 11:52:50 Count:
TS not enough memorny for indicator

Bid:1.904320 Spread:27 .9 Stoplewel:0.1 Tradeable:es

Solution

The bar history data takes up too much memory when loaded into RAM and the charts. The MT4 application
needs to be configured to keep less number of bars on the charts.

1. Inthe MT4 application menu select Tools > Options then select the Charts tab.
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2. Enter 512000 into the Max barsin history, and 65000 into the edit box Max barsin chart:

Options ? >

Events Community Signals
Server Charts Objects Trade Expert Advisors Motifications Email FTP

Show trade levels
[ Use "Alt' key to drag trade levels
Show QHLC
[ Show ask line
[ Show period separators
[ Color print
Save deleted charts to reopen

Max bars in history: |512000 ~ Max bars in chart: |65000 ~

Cancel Help

3. Attach the EA to the chart now. If the issue is still there then go back to the previous step and enter half of
the previous values. Keep repeating these two steps - halving the values every time - until the EA attaches
successfully.

5.17 No Trades Dueto Trade Disabled

Issue

The theTradeableADX EA got attached to a chart, the EA is up and running. It keeps submitting market ordersto
the broker server. However, the broker's server does not execute these market orders, instead, the broker saysthe
trade on this broker account is disabled:

MT4:133 tra

The broker server reports the MT4 error code 133, which means that the trade is disabled on the account. This
isnot an EA issue, instead, thisis an issue with the broker account. For some reason the broker account does not
allow you to trade that market.

Solution

1. Restart the MT4 terminal to seeif the restart and reconnect to the broker resolves this: In the MT4 menu
select File > Exit, wait 5 seconds then start the MT4 up again.

2. ldentify another symbol for the same market which is enabled for trading: In the MT4 menu select View >
Symbols and search for symbol with different/extra suffix in the name, like EURUSDecn. Add that symbol
to the Market Watch window then attach the EA to this new symbol.

3. Logging into your M T4 broker account with the investor login credentials disables trading. Ensure that you
log in to your broker account with the full trader login credentials.

4. Create another demo account with the broker.
5. Contact your broker and ask their support team to enable trading on the symbol or account

1. Your broker account may have reached some trade limits (e.g. overall maximum lots).
2. Your broker may have put (temporarily) trading limitations on your account for some reason.
3. Your broker may have to enable trading by EAs.
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5.18 How to L oad Setfile from the Settings Analysis Site for Backtesting

In this topic we guide you through how to download the EA settings from the Settings Analysis page, and load
those settings into the EA in the Strategy Tester of the MT4 application for backtesting.

1. First, download the set file: Go to the Settings Analysis page.

2. Click on the analysistype, FOREX or INDEX markets, for which you want to get the set file. For instance,
click on the Comprehensive analysis: Details link on the Settings Analysis page.

3. Right-click on the MT4 ® sign and sdlect Savelink as...

Leverage Timeframe 4| Symbol 4| Spread$ Set File4| Pass4 Model 4

100 H1  AUDJPY 3.0 MT4@ w=/A 792 Contenl & Ticl
Cpen link in new tab

100 H1 AUDUSD 3.0 MT4 G Open link in new window
Cpen link in incognito window

100 H1  EURAUD 4.0 MT4@
Save link as...

100 H1  EURJPY 3.0 MmTaG .Hkadh

100 Hi  EURUSD 3.0 MT4GQ  jnspect Ctrl+Shift<|

4. Click on Downloads in the Quick access list then click on the Save button:

€ Savess *
&« v 4 ; » ThisPC » Downloads N ] Search Downloads
Organise « Mew folder =z - 0
[ Desktop (ol MName Date modified Type
¥ Downloads ="
Mo items match your search,
= Documents
=] Pictures
W >
File name: | theTradeableADX MT4 e
Save as type: | SET File [*.5et) ~

5. Now load the set file into your EA in the MT4 Strategy Tester: Go to the MT4 Strategy Tester and click on
the Expert properties button:

A Hide Folders Cancel

- |

Period: |H1

Spread: |Current/" v |
~

Optimization

pert properties
Symbol properties
Open chart

Modify expert

Start

6. Click onthe L oad button:
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[™ Postion Action upon Trend...

[ i A v

Close Al Previ...| Keep All Positi...

o Amm e o an

Keep All Postti...
s

r an

theTradeableADX ? *
Testing Inputs  Optimization
Variable Value Start Step Stop ™
[T ==== ADX Indicator Settings
[ Entry Method [dropdown] ADX Trend & ... | ADX Direction... ADX Direction...
[~ ADX Period [3=2] 12 12
[T ADX Level [>=0] 25 25
[ Trend Following Method [dr...  Start of Trend...  Start of Trend... Start of Trend...

Load

oK

Save

Cancel Feset

7. Click onthe Downloads in the Quick access list then double-click on the set file:

CG Open

Organise « Mew folder

”~
v 3 Quick access

[ Desktop »
* Downloads
Documents

=1 Dirtrac - B3 BE

« v ; » ThisPC » Downloads v O o

Name

Today (1)
[ theTradeableADX MT4

File name: |*.set

Search Downloads

==+ [

Date modified

18/01/2021 19:33

v | Expert set (et

et

Type

SETH

8. Thisloads the settings from the set file into the EA parameters. Click on the OK button:

theTradeableADX ? *
Testing Inputs  Optimization
Variable Value Start Step Stop ™
[T ==== ADX Indicator Settings
[¥ Entry Method [dropdown] ADX Trend & ... | ADX Direction... ADX Trend & .
[ ADX Period [3=2] 40 4 & 40
¥ ADX Level [>=0] 10 10 5 40
[¥ Trend Following Method [dr... With the Tren...  Start of Trend... With the Tren...
¥ Postion Action upon Trend... | Close All Previ...| Keep All Positi... Close Al Previ... v
~ n e A e PRt L an e s an . —~ ~
Load Save

9. Run the backtest: Click on the Start button of the Strategy Tester:

V| | Expert properties |

H1 ~ | Symbol properties |

¢ |Current V| | Open chart |
Optimization [ | | Modify expert |

| R Gt |

Knowledgebase
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5.19 Backtest In Visual M ode Not Working

Issue

In the Strategy Tester using the visual mode DLL imports not allowed message appears on the chart. No result
after the Strategy Tester finished itsrun.

EURUSD.H1 (visual) =8 =R
EURUSD,H1 1.10180 110160 110160 1,10180
1.10860
on EURUSD H1 w/magic 20140328 140710
Status: HALTED Access: 0-0-0-0@pending Licensed until: pending '
Error Messag
: . . . . . 110565
ERROR 1082:5etup problem: DLL imports not allowed. In MT4 menu select Tools > Options and tidk "Allow DLL imports’ in Expert Advisors tab.
At Broker Time:2019.11.25 00:00:00 Local Time:2019.11.25 00:00:00 Count:1
1.10415
ik l
J*“qu“]' |I’{1 1.10270
15 Nov 2019 15 Nov 17:00 18 Nov 0%:00 15 Nov 01:00 19 Mow 17:00 20 Mov 05:00 21 MNov 01:00 21 Nov 17:00 22 Nov 0%:00

Global Allow DLL importsisnot enabled

Y ou may need to enable the DLL importsin the MT4 for terminal global parameters to run the theTradeableADX
EA in the backtest environment.

1. Openthe MT4 global Options by selecting Tools > Option (CTRL+O)

2. Select the Expert Advisorstab

3. Check the Allow DLL import

Options 7 e

Events Community Signals
Server Charts Objects Trade Expert Advisors Notfications Email FTP

Allow automated trading
Dizable automated trading when the accourt has been changed
Digable automated trading when the profile has been changed

[[] Disable automated trading when the charts symbol or period has been changed

Allow DLL imports {potentially dangerous, enable only for trusted applications)
[] Allow WebRequest for listed URL:

@ add new URL like hitps:/Awww mgl5.com’

Corcel | [ el

4. Restart the MT4: exit the M T4 application, wait 5 seconds then start it up again.

5.20 Backtest Not Working

Issue
After the backtest finished no result showing.
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# Time Type Order
B

@ Settings | Results | Graph | Report | Journal |
* | Bars in test 1077 Ticks n
Mismatched charts errors 0 |:

Initial deposit 10000.00

Total net profit 0.00 Gross ¢
Profit factor Expects
Absolute drawdown 0.00 Maxirn
Total trades 0 Short p
Profit t
Largest profit t
Average profit t

Tester

Graph | Report | Journal

Global Allow DLL importsisnot enabled

Settings Results

Knowledgebase

Y ou may need to enable the DLL importsin the MT4 for terminal global parametersto run the theTradeableADX

EA in the backtest environment.

1. Openthe MT4 global Options by selecting Tools > Option (CTRL+O)

2. Select the Expert Advisorstab
3. Check the Allow DLL import

Opticns
Events Community Signals
Server Charts Objects Trade Expert Advisors Motffications Email FTP
Allow automated trading
Digable automated trading when the account has been changed
Disable automated trading when the profile has been changed
[] Disable automated trading when the charts symbol or period has been changed
Allow DLL imports {potentially dangerous, enable only for trusted applications)
[] Allow WebRequest for listed URL:
& add new URL like hitps://www.mgl5.com’
Coca | [P0
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4. Restart the MT4: exit the MT4 application, wait 5 seconds then start it up again.

5.21 Connection Down M essage

Issue

The theTradeableADX EA got attached to a chart and the EA is up and running. The EA monitors the connection
between the MT4 terminal and the broker server. When the M T4 loses connection to the broker server then the
EA presents this Connection Down message in its dashboard - see the orange message as an example:

In the above screenshot the last connection issue happened at 14:19 broker server time (chart time).

This means that somewhere along the Internet connection path from your computer to the broker server, including
your home networks, the Internet and your brokers remote networks, there was some temporary issue resulting in
data transfer interruption.

During this time the theTradeableADX EA cannot receive price feed from the broker, i.e. no ticks are coming in.
This also means that, due to the lack of price feed and ticks, the EA is not activated and cannot perform trading or
managing open trades. When the M T4 re-establishes the connection to the broker server and price feed comesin
again then the EA automatically resumesits trading operations.

Solution
In order to minimize the downtime, please ensure the following:

1. Your computer is connected to your home networks over awire, i.e. cabled to your modem or router. Note
that wireless connectivity is more prone to connection issues.

2. Use acable based Internet service provider, if feasible. Wireless based Internet service providers, like
mobile or cellular based Internet providers could have more connectivity issues.

3. Turn off the sleep or hibernation mode on your computer. When your computer goes into sleep or
hibernation the Internet connection would be lost.

4. If in doubt, restart your home networks:. shutdown your computer, turn off your modem or router, wait 10
seconds then turn back on the modem/router then your computer.

Note that even the best Internet connection could see a handful of connection issues on a daily basis. When you
see more than a handful, like into 100 or more a day then your attention is needed.

5.22 Suspended Message

I ssue

The theTradeableADX EA got attached to a chart and the EA is up and running. After awhile the dashboard
shows the suspended message:

The suspended message simply tells you that the actual market spread got higher than the configured Max Spread
for Position Entry for a period of time.
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Solution

Here is an example screenshot where the Max Spread for Position Entry is set to 5 pips:

Expert - ? x

About Common Inputs  Dependencies

Variable Value &
ab | ==== Common Settings
ab | — Trade Limits

V| Max Spread for Position Entry, Pips 50  ef—

Load

v Save

Corcd | | P

The EA temporarily holds back trading activities while the market spread goes higher than the configured 5
pips, but will automatically resume the trading once the market spread drops back to or below the Max Spread
value. This provides a protection against trading during high spread periods like over night or during news or
announcements.

If you do not want trades to take place during high market spread periods then no change is needed. If you trade
amarket which has higher spread even during pesak of the trading sessions then you may want to adjust the Max
Spread settings accordingly higher.

For more information please refer to the Max Spread for Position Entry page

5.23 Computer Always-on

Question

How to ensure that Windows does not go into sleep or hibernation mode?

How to Turn off Sleep & Hibernation

Ensure that your computer is turned on throughout the FOREX market hours from Monday to Friday, and your
computer is running the M T4 application and the EA is attached to a chart. Simply leave your computer and the
MT4 up and running at all times. Please ensure that your Windows does not go into sleep or hibernation mode:
1. Goto Start > Windows Settings > Power & Sleep
2. Select Never in the dropdown:

< Settings = O x
@ Home Power & sleep
Find a setting yel Screen Save energy and battery life

Make your battery last longer by
System When plugged in, turn off after choosing shorter times for screen
and sleep settings

30 minutes ~
1 Display
Related settings
@) Sound Sleep Additional power settings
L1 Notifications & actions When plugged in, PC goes to sleep after
Never ~ Have a question?
J) Focus assist
Changing power mode
I O Power &5leep  gfmmmm— @ @

@ Gethelp

& Give feedback

= Storage

[#@ Tablet mode

gi Multitasking

{1 Droincting to thic O
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5.24 No Result in Optimization

Issue
After the optimization finished no result is showing in the Optimization Resultstab in the Tester
* | Pass Profit Total trades Profit factor  Expected Payoff Drawdown § Drawdown % Inputs
g Settings | Optimization Results | Optimization Graph | Journal |
For Help, press F1 Default Wil 2/0 kb

The following message was found in the Tester Journal tab There were X passes done during optimization, X
results have been discar ded asinsignificant.

*| Time Message &
_| @ 2018.09.09 19:18:07.541 I There were 10 passes done during optimization, 10 results have been discarded as insignificant ©
)

3| Settings | Optimization Results | Optimization Graph | Journal

For Help, press F1 Default i 26/0 kb

Solution

To resolve the "insignificant” issue before you start the optimization you may need to uncheck the Skip Useless
Resultsin the Optimization Result tab.

Profit Total trades Prc
Set Input Parameters
Eh Copy Ctrl+C
Copy All Alt+A
Save as Report
v Skip Useless Results
v  Show Input Parameters
v Aute Arrange A
v Grid G

ings | Optimization Results | [Dptimization Graph

1. Click the Optimization Resultstab in the Tester.
2. Right click in the empty area for the menu above.
3. Uncheck the Skip Useless Result menu

Profit Total trades Prc
Set Input Parameters
EE Copy Ctrl+C
Copy All Alt+A
Save as Report
Skip Useless Results
Show Input Parameters
Auto Arrange A
Grid G

ings

-| Optimization Results

Optimization Graph
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4. Rerun the optimization.

5.25 No Trades During Backtesting

Issue
After the backtest finished no trades are showing.

*# Time Type Order

Tester

Settings | Results | Graph | Report | Journal |

Bars in test 1077 Ticks i

X

Mismatched charts errors 0 I:

Initial deposit 10000.00

Total net profit 0.00 Gross [

Profit factor Expecte

Absolute drawdown 0.00 Maxim

Total trades ] Short p
Profitt

Largest profit t
Average profit t

Settings | Results | Graph | Report | Journal |

If you see no trades during backtesting then usually it is down to either EA settings issue or MT4 bar history
issue.

Tester

Run a Backtest in Visual Mode

In order to see any settings issue with the the theTradeableADX EA | would suggest to run a backtest in Visual
mode. Thiswould give a chance to see the EA dashboard and any error messagein it.

Go to the MT4 Strategy Tester window and tick the Visual mode box:

x

Expert Advisor ~ |

Symbal: | EURUSD, Euro ws LS Dollar

Model: | Control points (a very crude methoc

Use date From: |2020.04

W\/

Settings | Journal |
Tip: Inthe event of no Visual mode box is visible then follow the stepsin the Visual Mode Checkbox Missing
in Strategy Tester topic.
Do not forget to clear the Optimization box if it was ticked before:

Tester

w | Expert properties
siod: |H1 w Symbol properties
ead: Open chart
:l Optimization Modiy expert
]

Start
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Now run the backtesting in visual mode: click on the Start button. The Visual mode would make visible any
potential EA messages in the backtesting chart, giving hints for next steps.

Watch out for any red messages in the chart area.
Y ou may find these knowledge based topics useful to resolve them:

» Backtest In Visual Mode Not Working, and
* Backtest Not Working

Check the Bar History Quality

Once no errors are reported in the EA dashboard then you may turn off the visual mode and run the backtest.
Ensure that you use the Every tick mode during the backtest (Settings tab):

: Expert Advisor ~ |MOVing Average exd - | Expert properties
Symbol: | EURUSD, Euro vs US Dollar w Period: |H1 w Symbol properties
Model: | Every tick {the most precise method based on all available least timeframes Spread: Open chart
el From: To: Optnzation Mody expet
Visual mode [ Skip to 2020.05.0
_ Start
g Settings | Journal |
And double check that you get 90% modeling quality when you run the backtest (Results tab):
* | Barsin test 1410 Ticks modelled 1182085 Medelling quality J‘}D.Dﬂ% ~
Mismatched charts errors 0 | / |
Initial deposit 10000.00 Spread - Current (13)

If you get less than 90% then the bar history in your MT4 is not complete for the calendar period you test, and the
test results are not valid.

* | Bars intest 1529 Ticks modelled 1387257 Medelling quality 36.82% ~
Mismatched charts errors 0 [ |
Initial deposit 10000.00 Spread Current (13)

In this case you could download bar history from MetaQuotes: select in the MT4 menu the Tools > History
Center point, navigate in the symbolstree to the pair you test, double click on the 1 Minute (M1) node for that

pair then click on the Download button:
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History Center: EURUSD, M1 ? H
Symbals: Database: 9014 records
""" |§| EURPLM A Time Open High Low Close Volume  *™
""" ) ERTRY [] 2020.05.01 16:11 1.097886 1.09775 1.09766 1.09775 9
=-1%] EURUSD
s @ 2020.05.01 16:10 1.09772 1.09774 1.09756 1.09767 59
_____ 5 Minutes (M5) [] 2020.05.01 16:09 1.09753 1.09773 1.09759 1.09772 52
_____ 15 Minutes (M15) @ 2020.05.01 16:08 1.09734 1.09794 1.09760 1.09761 63
..... 30 Minutes (M30) @ 2020.05.01 16:07 1.09808 1.09306 1.09784 1.09794 58
..... 1 Hour {H1) [] 2020.05.01 16:06 1.09792 1.09808 1.09791 1.09806 33
----- 4Hours (H4) [] 2020.05.01 16:05 1.09785 1.09310 1.09781 1.09793 62
----- Daily (01) [) 2020.05.01 16:04 1.09750 1.09787 1,09750 1,09786 62
""" Wreekly (W) @ 2020.05.01 16:03 1.09765 1.09765 1.09749 1.09745 47
5 Monthly (MN) @ 2020.05.01 16:02 109777 109778 1.09750 1.09754 &4
----- || GePALD
— [] 2020.05.01 16:01 1.09751 1.09777 1.09761 1.09777 54
----- [#] GBPCAD
_____ &) cePCHF @ 2020.05.01 16:00 1.09801 1.09801 1.09759 1.09760 a5
_____ @) GePIPY [] 2020.05.01 15:59 1.09781 1.03803 1.09780 1.09800 61
..... [#) GBPNZD @ 2020.05.01 15:58 1.09780 1.09784 1.09770 1.09777 64
..... (%) cBPUSD [] 2020.05.01 15:57 1.09754 1.09780 1.09764 1.09777 39
..... [#] nzpcap [J 2020.05.01 15:56 1.09764 1.09768 1.09759 1.09765 57
----- (%] nzDCHF @ 2020.05.01 15:55 1.09788 1.09790 1.09764 1.09764 62
[&] mFrniow / e o w2
Download / Add Edit Delete Export Import

Note that the downloaded bar history will be from MetaQuotes, not from your broker. There could be some
differencesin the bar history therefore your backtesting results may somewhat differ from your own broker.

x

Download Warning ?

You are going to download data from the "MetaQuotes Software Corp.™
1. history center, but your account s opened on the “Blueberry Markets Pty Ltd”
trade server.

Please do not forget that the downloaded history data can differ from the data stored
on the trade server. This is why these data cannot be used in disputes over historical
prices with "Blueberry Markets Pty Ltd". If you stil want to continue, press CK.

oK

Cancel

Once you downloaded the bar history agood practice is to restart the MT4: exit the MT4, wait 5 seconds then

start it up again.

Now re-run the backtest with Every tick mode and check if you get the 90% modeling quality, and see the

trading results.

5.26 Visual M ode Checkbox Missing in Strategy Tester

Issue
Visual mode checkbox is missing in the Strategy Tester.

=

Expert Advisor ~ |Mo\ring Average exd - |
Symbal: ~ Period: |H1 ~
Model: | Every tick fthe most precise method based on all available least timeframes Spread:
Use date Optimization

Expert properties
Symbol properties
Open chart

Modify expert

Start

Tester

Settings | Journal |

Solution

The Strategy Tester window hides some control elements when the window itself is not tall enough, i.e. the
Visual mode checkbox could become hidden. Make the Strategy Tester window taller in order to make all the

control elements visible, like the Visual mode chechox.
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Hover the mouse over the top edge of the Strategy Tester window and drag the edge upwards:

1 [x
|Expert Advisor V| |Mo\ring Average exd v| | Expert properties |
Symbol: | V| Period: |H1 V| | Symbol properties |
Model: | Every tick {the most precise method based on all available least timefr w | Spread: |C|.|rrent ~ | | Open chart |
o T e
i by
2
. Settings | Journal |
}Er Help, press F1 | Default | | | | | | | Wi 2706/1 kb A
L
x
|Expert Advisor V| |Mo\ring Average exd v| | Expert properties |
Symbol: | V| Period: |H1 V| | Symbol properties |
Model: | Every tick {the most precise method based on all available least timefr w | Spread: |C|.|rrent ~ | | Open chart |
o ) e
B _“
. Settings | Journal |
}Er Help, press F1 | Default | | Wi 271471 kb A
3. |= =
|Expert Advisor V| |Mo\ring Average exd L v| | Expert properties |
Symbol: | V| Period: |H1 V| | Symbol properties |
Madel: | Every tick {the most precise method based on all available least timefi e | Spread: |C|.|rrent ~ | | Open chart |
o T e
Visualmode [ ] | ] l:‘ Skip to M
5
. Settings | Journal |
For Help, press F1 Default | | Wi 2719/1 kb 4
4. [«
|Expert Advisor V| |Mo\ring Average exd v| | Expert properties |
Symbol: | V| Period: |H1 V| | Symbol properties |
Model: | Every tick {the most precise method based on all available least timefr w | Spread: |C|.|rrent ~ | | Open chart |
o e ot ) [ Wodbyomet |
Visual mode@ [ ] l:‘ Skip to M
5
. Settings | Journal |
For Help, press F1 Default | | Wit 2736/1 kb A
5. |=
|Expert Advisor V| |Mo\ring Average exd v| | Expert properties |
Symbal: | V| Period: |H1 V| | Symbol properties |
Model: | Every tick {the most precise method based on all available least timefr w | Spread: |C|.|rrent ~ | | Open chart |
o T e
Visual mode [¥] | [ m Skip to [0200430 @~
§
o
. Settings | Journal |
Foi

r Help, press F1 Default | 1 2740/1 kb 4

5.27 Step-by-step Installation of Expert4x EAsand Indicators

In thistutorial the name of MetaTrader is used as an example. Replace the MetaTrader with your broker specific
MetaTrader name.

1. Start your MT4 terminal and select the File > Open Data Folder menu

Page 58



File | View  Insert

Charts  Tools  Window H

[ Mew Chart

E}N Open Offline
Open Deleted
Profiles
Close

Save As

’L_'E] Save As Picture...

ew Order

[

Hi 116217

I3
Ctrl+F4
Ctrl+5

0

Open Data Folder

Open an Account

Login to MCGL5.co

-l
Py

Print Setup...

Print Preview

m
i

Print...

[

Exit

Login to Trade Account

N
0 |

mmunity

Ctrl+P

1l

The menu opens aFile Explorer.

Closeyour MT4

Check the File Explorer

» If theFile Explorer shows afolder like this one below

Knowledgebase

| 6EEODB13AE2FDFS8D9A4BOGE319DCAIA

Share View
Tl « AppData » Roaming » MetaQuotes » Terminal » GEEODB13AEZFDFI2D9A4BOGE319DCAOA » v O
v MetaQuotes A Name - Date modified
Crashes config
i Terminal history
1DAFDIATCETDCBAFEITEAATFCIESCFTS logs
1E4DFOF778108F3C1AD30B82167218B1 MOL4
3A2E25631C50ATEBA25C5500CASBATAS profiles
v | | GEEODB13AE2FDFO3DIA4BOGE319DCAIA templates
config e
history
logs
MQL4
profiles
templates
tester
9BF2ECB26BDEB55D5380967E9AT26144
9662CH1C6715C26397817D3043CECEEC .
&items

Search 6EEODB13AE2FDFI8D9.. @

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
TXT File

Size

x

TKB

and you see the origin.txt or the origin file go to the standard installation page.

» If the File Explorer shows afolder like this one below
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| d = | MetaTrader — O X
Home Share View o

- - 1~| + ThisPC 5 Locsl Disk (C:) » Program Files (xB6) » MetsTrader » v & | Search MetaTrader P
Internet Explorer e Name - Date modified Type Size
Lz TR config File folder
config history File folder
history MOL4 File folder
MOL4 profiles File folder
profiles Sounds File folder
Sounds templates File folder
| | DDE-Samplexis XLS File 10 KB
templates O metaeditor.exe Application 9,873 KB
MetaTrader - AxiTrader Application 10,972 KB
MetaTrader - RoboForex kg terminal.ico lcon 45 KB
MetaTrader 4 FinFX Q uninstall.exe Application 1,382 KB
MetaTrader 4 1C Markets
Microsoft SDKs
Microsoft. MET
OANDA MetaTrader
Reference Assemblies v
11 items =

and you see the terminal .exe or terminal file go to the non-standard installation page.

5.27.1 Standard EA, Indicator installation

In the opened File Explorer the origin.txt or the origin file was found.
Please follow through the steps below to install the Expert4x EA or Indicator on your MT4
1. Doubleclick theorigin.txt file and take a note of the MetaTrader location.

" originxt - Motepad - O Lt

File Edit Format View Help
k::\ngram Files (x86)\MetaTrader 4

2. Start the EA or indicator setup program. Follow through the setup until you reach the Select Tar get
MetaTrader Directory window.
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ﬁl Setup - EA -
Select Target MetaTrader Directory
Far which MT4 location should EA be installed?
Setup will install the EA under the selected MT4 instance.

(O c:\Program Files (x86)\MetaTrader 4 IC Markets's Data Folder
() C:VProgram Files (x86)\ThinkForex Australia MetaTrader 4's Data Folder

L) C:\Program Files (x36)\0ANNA MetaTrader's Data Folder

(O} C:\Program Files (x36)\MetaTrader 4's Data Folder

—

(O) Ci\Program Files (x86)\MetaTrader 4 FinF¥'s Data Folder

(O) C:\Program Files (x86)\MetaTrader's Data Folder

t J o] Frogram Files 3(55” alinex Meta [rader 4 - Ul's Uata Folder

(0) C:VProgram Files (x36)\MetaTrader - RoboForex's Data Folder
(O) C:\Program Files (x86)\MetaTrader - AxiTrader's Data Folder

Knowledgebase

3. Inthiswindow select your targeted MetaTrader's Data Folder, as per the origin.txt noted earlier, and click

Next
4. Follow through the rest of the setup application.
5. Inthe end click I nstall

ﬁ! Setup - EA
Ready to Install
Setup is now ready to begin installing
computer,

change any settings.

EA on your

Click Install to continue with the installation, or dick Back if you want to review or

Target Metatrader location:
C:\Program Files (x86)WMetaTrader 4

Target Metatrader data folder location:

Users Guide location:
C:\Users \AppData\Roaming

C:'\Users| \AppData'\Roaming\MetaQuotes{Terminal\S0CA3SDFE510CC5AS

< Back Install Cancel

6. Check the EA or Indicator in the MetaTrader after installation

a) Start your MetaTrader

b) Inthe Navigator panel open the Expert Advisors section if you installed an EA or the Indicators
section if you installed an Indicator and look for the EA or Indicator.

5.27.2 Non-standard EA, Indicator installation

In the opened File Explorer the terminal.exe or terminal file was found.
Please follow through the steps below to install the an Expertdx EA or Indicator on your MT4

1. Right click on the name of the Setup application
2. Select Run asadministrator (You may get afew security warning or you may need to typein the

Windows administrator password)
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I &) Run as administrator -(—*-"'"'

Troubleshoot compatibility
Pin to Start
Edit with Motepad++

Shred using AVG

M§ Scan selected items for viruses
L
|& Share

Give access to >
Pin to taskbar

Restore previous versions

Send to >

Cut
Copy

Create shortcut
Delete

Rename

Properties

3. Follow through the application until you reach the Select Target MetaTrader Directory window.

4. Click Add target directory... button

]LE,' Setup - EA —
Select Target MetaTrader Directory
Far which MT4 location should EA be installed?
Setup will install the EA under the selected MT4 instance.

() C:VProgram Files (x36)\MetaTrader 4 IC Markets's Data Folder

(O) CiVProgram Files (x86)\ThinkForex Australia MetaTrader 4's Data Folder
(O) Ci'Program Files (x36)\OANDA MetaTrader's Data Folder

(O) C:VProgram Files (x86)\MetaTrader 4's Data Folder

(O) C:\Program Files (x86)\Tallinex MetaTrader 4 - 01's Data Folder

(O c:'\Program Files (x86)\MetaTrader 4 FinFX's Data Folder

() C:VProgram Files (x36)\MetaTrader - RoboForex's Data Folder

() C:\Program Files (x36)\MetaTrader - AxiTrader's Data Folder

() C:VProgram Files (x86)\MetaTrader's Data Folder

| Add target directory... I

- Expertdx

< Badk Mext = Cancel

5. Navigate to your MetaTrader folder

Knowledgebase
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6. Scroll down to the end of the list. Select the target directory. Click Next.

Browse For Folder

Select a MT4 target folder in the list below, then dick OK

Videos
v g Local Disk (C)

bin
dev
PerfLogs
Program Files
I v Program Files (x36) I
Application Verifier

Commaon Files

Google

Inne Script Studio

Inno Setup 5

Internet Explorer

MetaTrader

MetaTrader - AxiTrader

MetaTrader - RoboForex
cenfig

history

Cancel

and click OK.

ﬁl Setup - EA

Select Target MetaTrader Directory
Far which MT4 location should

EA be installed?

Setup will install the

EA under the selected MT4 instance.

() C:\Program Files (x36)\MetaTrader 4 IC Markets's Data Folder

() C:V¥Program Files (x86)\ThinkForex Australia MetaTrader 4's Data Folder
(O) CiVProgram Files (x36)\OANDA MetaTrader's Data Folder

(O) Ci\Program Files (x86)\MetaTrader 4's Data Folder

(O) C:VProgram Files (x86)\Tallinex MetaTrader 4 - 01's Data Folder

(O) ¢:\Program Files (x86)\MetaTrader 4 FinFX's Data Folder

(O) C:'\Program Files (x86)\MetaTrader - RoboForex's Data Folder

() C:VProgram Files (x36)\MetaTrader - AxiTrader's Data Folder

() C:\Program Files (x36)\MetaTrader's Data Folder

(®) C:\Program Files (x86)\MetaTrader 4 Folder

| Add target directory...

- Expertdx

< Back Mext = Cancel

7. Follow through the rest of the setup application.

8.

Inthe end click | nstall

Knowledgebase
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ﬁ%‘ Setup - EA -
Ready to Install
Setup is now ready to begin installing EA on your
computer.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Target Metatrader location:
C:\Program Files (x86)WMetaTrader 4

Target Metatrader data folder location:
C:\Program Files (x86)WMetaTrader 4

Users Guide location:
C:\Users \AppData\Roaming’

< Back Instal Cancel

9. Check the EA or Indicator in the MetaTrader after installation

a) Start your MetaTrader

b) Inthe Navigator pand open the Expert Advisors section if you installed an EA or the Indicators
section if you installed an Indicator and look for the EA or Indicator.

5.28 How to download an EA setup in VPS environment

Knowledgebase

In this topic we guide you through the EA setup application download in V PS environment.
1. Start the File Explorer

Click the File Explorer

The File Explorer started.
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= | = | Libraries
Home Share hi ey
T ‘J_J b Libraries » v & | Search Libraries
[ Fawvorites E & Documents
B Desktop e Library
4 Downloads \
= Recentplaces —\p,l- Music
_L‘_ ”d Library
Libraries
Nj Pictures
£ Documents % Library
o Music o
= Pictures E Videos
B videos Wl Library
M Coamputer
iy Systerm (T
*:li_i Metwark
4 iterns

2. Select the address bar section

Libraries
Haome Share Wiew ﬂ
T & v| r_‘,.| | Search Libraries o |
{ Favorte & Docurnents
B Desktop —_— Library
& Downloads \
‘| Recent places ,_‘Ipl. Mlusic

3. Typein: https://my.eafactory.com/expertdx and press Enter to start the Internet Explorer

= = | Libraries
Haome Lhore T ﬂ
= https:,-',-'my.eafactory.cumfexpert4>4 M v| - | Search Libraries 0 |
g
7 Favorites & Docurments
BE Desktop -l Libirary
Downloads
& A

Did you get blank screen? As you see below:
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e°| 2 httpsmyeafactony., O - @ 2 O ” (2 Expertdx | | # A

If yes, please select the address bar in the Internet Explorer and type in: https://my.eafactory.com/
Userlnterface/index.zul ?p=1

eal = hitps://ryeafactony., O - @ 2 Gl |2 Expertds ‘ ‘

If you got this message below you may need to adjust temporary your Internet security settings.

Sorry, JavaScript must be enabled.
Change yvour browser options, then

4. When the Web support Siteis appeared please log in
5. Select the EA name from the Product List and click Product Download in the Release List

e@k—g} https:/ /iy eafactong..., O~aic || :%Web Support

[ |
Expert4x

Product List Release Notes
Experﬁx ~ . . | Mavigation

' Expert4x Version Downioad Area
Experﬁx ! @ 1.0.0 Expert Advisor User Control Panel

Expertdx / for MT4 platform
/ Logout
Expert4x w 11 December, 2013

Release List Quick installation instructions

. Download the setup application

Guide s Download . Exit the MT4 application if 1t was running

. Start off the downloaded setup application
/ . Select an existing MT4 main folder for setup

@ target
Note
The MT4 folder must exist. Select the top
level MT4 folder which contains the
terminal exe application.
An example top level MT4 folder name:
'C:\Program Files\MetaTrader - Alpari UK’
L4 >

Services powered by EAfactory.com Web Support Site v1.0.0

Users Product

A"
= L b =
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If you got this message below you may need to adjust temporary your Internet security settingsto enable
downloads.

Security Alert -

! Wour current security settings do not allow this file to be downloaded,

LITC VLI T IOIPCL IOl WAL oot s

Warning messages related to the download
* Do youwant to save theTradeableADX EA_v1.0.0_Setup.exe...?
An example top level MT4 folder

LTy 1 g ™ 1

b

Do you want to save w1.0.0_Setup.exe from my.eafactory.com?

& This type of file could harm your computer. 3 Save i | Cancel

Click Saveto resolve thiswarning
» |If you use Internet Explorer 9.0 you may get this message:

theTradeableADX EA _v1.0.0_Setup.exeisnot commonly downloaded and could harm your
computer

This message is anew featuresin Internet Explorer 9.0. |E 9.0 has increased user security.

"When you download a program from the Internet, SmartScreen Filter will check the program
against a list of programs that are downloaded by a significant number of other Internet Explorer
users and a list of programs that are known to be unsafe. If the program you're downloading isn't on
either list, SmartScreen Filter will display a warning that the file isn't "commonly downloaded.” It
doesn't necessarily mean the website is fraudulent or that the programis malware, but you probably
shouldn't download or install the program unless you trust the website and the publisher."

Source: http://windows.microsoft.com/en-US/windows7/SmartScreen-Filter-frequently-asked-
questions-1E9?Signedin=1

These are the steps if you'd like to continue installing the theTradeableADX EA EA:

1. Click the Action button in the displayed message
2. Inthe dialog box click the down arrow to the left of More options, and click Run anyway
6. After the successful download the Internet Explorer may show this message

An example Top 1eVel V114 Tolaer
name: 'C'\Program Files'\MetaTrader

> The publisher of _v1.0.0_5etup (2).exe couldn't be verified. -
@ Learn more —3 Run View downloads
>

To start the installation process after the download click Run
7. Clean up after the download in the Internet Explorer

5.28.1 How to enable JavaScript in your Internet Explorer

Issue
| tried to load the Web Support Centre in the I nternet Explorer But the following error message popped up.
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Sorry, JavaScript must be enabled.
Change vour browser options, then

JavaScripts aredisabled in the Internet Explorer
To load the Web Support Centre you may need to enable the usage of JavaScript in the Internet Explorer

1. IntheInter Explorer click Toolsicon
2. Select Internet options

Primt »
File »
Loorm (1005 3
Safety 3
T | Add site to Start Screen
@ Wiew downloads Ctrl +)

Manage add-ons
F12 developer tools
Go to pinned sites

*Internet nq{iﬁnns

ASPOUT R fet Caplorelr

3. Go to the Security tab
4. Select Custom level

Page 68


https://my.eafactory.com/expert4x

Internet Options _

Select a zone to view ar change security set;ings.

’aral | Security g Conkent | Connections | Praograms | fdvanced |
%—;'Ll—-_____‘

@ & v O

Local inkranet  Trusted sites  Restricted
sikes

Internet

Sik
e This zone is For Inkernet websites, tes

except those listed in trusted and
restricted zones,

Security level For this zone
Allowed levels For this zone; Medium to High
High
- Appropriate For websites that might have harmful
cantent

- Maximum safequards
- Less secure features are disabled

Enable Protected Flode crequires restarting [ntedhet Explorer)

Cuskom lewvel. k

efault level

| Reset all zones to default level

| (0] 4 | | Cancel Apply

5. Scroll down until you see Scripting
6. Under the Active scripting select Enable
7. Click OK

Knowledgebase
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Internet Options 7| X
Security Settings - Internet Zone
|| 'websites in less privileged web content zone can navigate inj ~

® Disable
) Enable @ -
() Prompt (

= | Seripting .
=1 Fictive scripking __,..@
() Disable
O]
) Pro
= | BOeT Progranmat cipboard access
® Disable
) Enable
@] Prompk
=] Allove status bar updates via script
(® Disable
(T Ermshla hd
£ m >

Settings

*Takes effect after ywou restart wour computer

Reset custom setkings

Reset o [igh (default) vl | Reset.. |
@ > ok | [ |cance |
B i ey
8. Click OK

Warning! .

[ _a| fre wou sure wou want to change the settings for this zone?
k4

| ____.l.)p ‘r’es[}|| Mo

9. Refresh the https://my.eafactory.com/UserInterface/index.zul ?p=1 page ang login

5.28.2 How to Enable Download in your Internet Explorer

Issue

| tried to download the EA setup application in the Inter net Explorer But the following error message popped
up.
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Security Alert -

! YWour current security settings do not allow this file to be downloaded,

0]4

IIIc IFfL LT IJICPCL IOl alelh. A lo b CITx

Filedownload isdisabled in the Internet Explorer
To download afile you may need to enable the Download in the I nter net Explorer

1. IntheInter Explorer click Toolsicon
2. Select Internet options

Print 2
File r
Foorm {1005 3
Safety 4
Y~ Add site to Start Screen
@ Wiew downloads Ctrl+]

hanage add-ons
F12 developer tools

Go to pinned sites

Internet options

DoLLIRterfet Eaplorelr

3. Gotothe Security tab
4. Select Custom level

Knowledgebase
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Select a zone to view ar change security set;ings.

’aral | Security g Conkent | Connections | Praograms | fdvanced |
%—;'Ll—-_____‘

@ & v O

Local inkranet  Trusted sites  Restricted
sikes

Internet

Sik
e This zone is For Inkernet websites, tes

except those listed in trusted and
restricted zones,

Security level For this zone
Allowed levels For this zone; Medium to High
High
- Appropriate For websites that might have harmful
cantent

- Maximum safequards
- Less secure features are disabled

Enable Protected Flode crequires restarting [ntedhet Explorer)

Cuskom lewvel. k

efault level

| Reset all zones to default level

| (0] 4 | | Cancel Apply

5. Scroll down until you see Downloads
6. Under the File download select Enable
7. Click OK

Knowledgebase
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‘ Internet Options ?| x
Security Settings - Internet Zone

Settings

(1 _Dworack

)
,3'-3 D;wvloads @
|&% Filz download @
) Disable ‘_______-—"’"
®

W
® Disable
() Enable
O Prarmpk
,_'j Enable \MET Framework setup
® Disable
(C) Enable
|| Miscellaneous
|| Acress data sources across domains

® Disable
™1 Ermzhla
< m >

*Takes effect after vou restart vour computer

Reset custom settings

Reset to: |High(default) v| | Reset,.. |

@ _,___.——'-P ok, | | Cancel |

T1 e T Ty ‘

8. Click OK

Warning! -

[ _’| Are wou sure wou wank o change the setkings For this zone?
k4

| ___...I.)p ‘r’es[}|| Mo

9. click the Product Download button again

5.28.3 Clean up after thedownload in the Internet Explorer

In this topic we guide you through how to clean up after download in VPS environment.

1. IntheInter Explorer click Toolsicon
2. Select Internet options
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Loorm (1005 3
Safety 3
Add site to Start Screen

Wiew downloads Ctrl +)

hanage add-ons

F12 developer tools

Go to pinned sites

Internet nq{inns

DOLTIATerfet Explorelr

3. Go to the Security tab

Internet Options \_?-_

Gendral | SEcuUrity - Conkent | Conneckions | Programs | Advanced |

Select a zone to view or change security setkings,

@ & v 0

Local inkranet  Trusted sites  Restricted

<

sites L

Internet o -

@ This zone is For Inkernet websites, fes B
except those listed in trusted and

restricted zones.,

Security level For this zone
Allowed levels For this zone: Medium ta High
High
- Appropriate For websites that might have harmful
conkent

- Maximum safequards
- Less secure Features are disabled

Enable Protected Mode (requires restarting Internet Explorer)
Custarn level,.. Default level

| Reset all zones to default level

| ok | | Cancel Apply

4. Click the Default level
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General | Security |F‘rivac~; I Content | Connections I Programs | Advanced

Select a zone ko wiew of change security setkings.,

@ & v O

Internet Local intranet  Trusted sites  Restricted
sites

e
ites
0 This zone is for Internet websites,

except those listed in trusted and
restricted zones.

Security level For this zone

Custom
Cuskam sektings,
- To change the settings, click Custom lewvel.
- To use the recommended settings, click Default level,

[#] Enable Protected Mode {requires restarting TTEernet Explorer]

Custam level. .. Default lewvel

Reset all zones to default level

| | Cancel | | Apply

5. Click OK

Knowledgebase
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Genetal | Security |Privac';-' | Conkent | Connections | Programs | Advanced |

Select a zone ko view or change security setkings,

@ &« / O

Internet Local inkranet  Trusted sites  Restricted
sikes

Internet

Sik
@ This zone is For Inkernet websites, es

except those lisked in trusted and
restricted zones,

Security level For this zone
Allowed levels For this zone: Medium to High
High
- Appropriate For websites that might have harmful
conkent

- Maximum safeguards
- Less secure Features are disabled

Enable Protected Mode {requires restarting Internet Explorer)
Custom level. .. Default level

| Reset all zones to default level |

XOK h

| Cancel | | Apply |

)
0%

=
a7

5.29 How to enable JavaScript in your Internet Explorer

Knowledgebase

Issue

| tried to load the Web Support Centre in the I nternet Explorer But the following error message popped up.

Sorry, JavaScript must be enabled.
Change vour browser options, then try again.

JavaScripts aredisabled in the Internet Explorer

To load the Web Support Centre you may need to enable the usage of JavaScript in the Internet Explorer

1. Inthelnter Explorer click Toolsicon
2. Select Internet options

Page 76


https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x

.

hanage add-ons

F12 developer tools
\ Go to pinned sites

Loorm (1005 3
Safety 3
Add site to Start Screen

Wiew downloads Ctrl +)

Internet nq{inns
l=

| DOLTIATerfet Explorelr

3. Go to the Security tab
4, Select Custom level

Internet Options

@ al

B

Security g Conkent | Conneckions | Programs | Advanced |

_-"--__-' @
Select a zone ko view or change security settings,

@ @«

Local inkranet  Trusted sites  Restricted

o

sikes

@

Internet

This zone is For Inkernet websites,
except those lisked in trusted and
restricted zones,

Security level For this zone

Allowed levels For this zone: Medium to High

High

Sikes

- Appropriate For websites that might have harmful

cantent
- Maximum safeguards
- Less secure Features are disabled

Enable Protected Flode rrequires restarting Inte

Custom lewvel.. k

ek Explorer)

efault level

| Reset all zones ta

default level

| (a4 | | Cancel

Apply

5. Scroll down until you see Scripting
6. Under the Active scripting select Enable

7. Click OK

Knowledgebase
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Internet Options X

Security Settings - Internet Zone

Settings

|| 'websites in less privileged web content zone can navigate inj ~

® Disable
) Enable @ -
() Prompt (

= | Seripting .
=1 Fictive scripking __,..@
() Disable
O]
) Pro
= | BOeT Progranmat cipboard access
® Disable
) Enable
@] Prompk
=] Allove status bar updates via script
(® Disable
(T Ermshla hd
£ m >

*Takes effect after ywou restart wour computer

Reset custom setkings

Reset o [igh (default) vl | Reset.. |
@ > ok | [ |cance |
B i ey
8. Click OK

Warning! .

[ _a| fre wou sure wou want to change the settings for this zone?
k4

| ____.l.)p ‘r’es[}|| Mo

9. Refresh the https://my.eafactory.com/UserInterface/index.zul ?p=1 page ang login

5.30 How to Enable Download in your Internet Explorer

I ssue

| tried to download the EA setup application in the Inter net Explorer But the following error message popped
up.
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Security Alert -

! YWour current security settings do not allow this file to be downloaded,

0]4

IIIc IFfL LT IJICPCL IOl alelh. A lo b CITx

Filedownload isdisabled in the Internet Explorer
To download afile you may need to enable the Download in the I nter net Explorer

1. IntheInter Explorer click Toolsicon
2. Select Internet options

Print 2
File r
Foorm {1005 3
Safety 4
Y~ Add site to Start Screen
@ Wiew downloads Ctrl+]

hanage add-ons
F12 developer tools

Go to pinned sites

Internet options

DoLLIRterfet Eaplorelr

3. Gotothe Security tab
4. Select Custom level

Knowledgebase
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Select a zone to view ar change security set;ings.

’aral | Security g Conkent | Connections | Praograms | fdvanced |
%—;'Ll—-_____‘

@ & v O

Local inkranet  Trusted sites  Restricted
sikes

Internet

Sik
e This zone is For Inkernet websites, tes

except those listed in trusted and
restricted zones,

Security level For this zone
Allowed levels For this zone; Medium to High
High
- Appropriate For websites that might have harmful
cantent

- Maximum safequards
- Less secure features are disabled

Enable Protected Flode crequires restarting [ntedhet Explorer)

Cuskom lewvel. k

efault level

| Reset all zones to default level

| (0] 4 | | Cancel Apply

5. Scroll down until you see Downloads
6. Under the File download select Enable
7. Click OK

Knowledgebase
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j Internet Options ?| x

Settings

(1 _Dworack

@ Dovnloads
@ File download

() Disable
o |
m—

® Disable
() Enable
O Prarmpk
@ Enable \MET Framework setup
® Disable
(C) Enable
u Miscellaneous
u Arcess data sources across domains

® Disable
1 Erzhl
[<] m

*Takes effect after vou restart vour computer

Reset custom settings

Resef to: |High {default)

@___.-

8. Click OK

@ Are wou sure wou wank o change the setkings For this zone?

____—h- ‘r’es[}| | Mo

9. click the Product Download button again
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Chapter

6

Operational Messages

The theTradeableADX EA operational messages and resolution guide.

Expert Advisors Operational Messages

Observe the message number displayed in red in the EA dashboard. Find that EA code in the table below and
click on that number to see the details and possible resolutions:

EA Code Severity Message Description
. . Configuration setting is missing
aﬁiﬁg?ﬁ'gf}&ﬁ;& IIDrTl]_[IJ_Oﬁ ngrtts to allow the EA to use dynamicaly
1001 Error in Comrﬁon tab of the pro ert[i)es loaded libraries (DLLS). Enable the
: prop load of DLLsand restart the EA.
window.
More...
Incomplete EA installation: Run Product installation is not compl _ete or
e : damaged. Run the setup application
1002 Error setup application for MT4 instance for the MT4 terminal instance as
"<MT4DataPath>'s Data Folder" .
displayed. More...
MT4 Expert Advisors are disabled: EA does not perform its operations,
1006 Error click AutoTrading icon on MT4 not monitoring nor reacting to price
toolbar to execute the EA. movements of the market. More...
Livetrading is not allowed (no smiley | The EA isunableto perform trading
1007 Error face): press F7 and tick Allow live operations, thereisasad icon in the
trading box on Common tab. top right corner of the chart. More...
Authentication failed or interrupted The EA is not able to authenticate the
(<Stopped>, <Status>, <Response>, : .
1008 Error : user access to the service at its start
<Reason>, <FlipOverCount>, .
up time. More...
<Latency>)
Initial risk <Initial RiskPercent>% Position sizing feature is enabled but
1017 Error istoo low. Set EA parameter 'Initial no Initial Risk Percent or Initial SL is
Risk Percent' to higher than zero. configured. More...
Initial SL <Initial StopLoss> is too Position sizing feature is enabled but
1018 Error low. Set EA parameter 'Initial SL for no Initial Risk Percent or Initial SL is
New Position' to higher than zero. configured. More...
2101 Error Initialization failed Initialization failed More...
The user quits the authentication
2118 Error Service access disabled (<AccessID>, process, or the EA isnot ableto
<Confirmationl D>) - shutting down... authenticate the user access to the
service. More...
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EA Code Severity Message Description
9104 Error | Order submit failed at bid ... Broker server rgjects orders submitted
by the EA. More...
Dynamic Target requires a Take .
15002 Error Profit. Set EA parameter Take Profit Dynamic 'Far_get fegture enabled but no
) Take Profit is configured. More...
to higher than zero.
Dynamic Stop requires a Take Profit. .
15004 Error Set EA parameter Take Profit to Dynamic _st<_)p fea“.”e enabled but no
. Take Profit is configured. More...
higher than zero.

MetaTrader Operational M essages

Observe the message number displayed in whitein the EA dashboard. Find that MT4 code in the table below and

click on that number to see the details and possible resolutions:

MT4:132 inatket is closed

MT4 Code Severity Message Description
5 Error Common error Connection, broker account or market
' related error. More...
The market price moved in the
129 Error Invalid price. meanwhile making the pricein the
order not feasible. More...
132 Error Market is closed. M ""Tke‘ Is closed, trading is not
available. More...
133 Error Tradeis dissbled. Broker disabled trading on this
account. More...
No current prices available or a
136 Error Off quotes. broker configured limit breached.
More...
. The broker account does not allow for
Amount of open and pending orders .
148 Error - more open or pending orders on the
has reached the limit.
account. More...
4024 Error Internal error. MT4 terminal internal issue. More...

6.1 Operational M essages

Expert Advisor Operational Messages.

Expert Advisors Operational Messages

Observe the message number displayed in red in the EA dashboard. Find that EA code in the table below and
click on that number to see the details and possible resolutions:
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EA Code Severity Message Description
) . Configuration setting is missing
aslilése%mﬂg&ﬁ;vb IIDTFI)_Oﬁ ngrtts to allow the EA to use dynamicaly
1001 Error in Com|;non tab of the bro ertri)eﬁ loaded libraries (DLLS). Enable the
; brop load of DLLs and restart the EA.
window.
More...
Incomplete EA installation: Run Product installation is not cor_nplfate or
- : damaged. Run the setup application
1002 Error setup application for MT4 instance for the MT4 terminal instance as
"<MT4DataPath>'s Data Folder" ;
displayed. More...
MT4 Expert Advisors are disabled: EA does not perform its operations,
1006 Error click AutoTrading icon on MT4 not monitoring nor reacting to price
toolbar to execute the EA. movements of the market. More...
Livetrading is not allowed (no smiley The EA is unable to perform trading
1007 Error face): press F7 and tick Allow live operations, thereisasad icon in the
trading box on Common tab. top right corner of the chart. More...
Authentication failed or interrupted . .
(<Stopped>, <Status>, <Response>, The EA isnot ableto guthen_tlcate the
1008 Error . user access to the service at its start
<Reason>, <FlipOverCount>, ub time. More
<Latency>) p )
Initial risk <Initial RiskPercent>% Position sizing feature is enabled but
1017 Error istoo low. Set EA parameter 'Initial no Initial Risk Percent or Initial SL is
Risk Percent' to higher than zero. configured. More...
Initial SL <Initial StopLoss> istoo Position sizing feature is enabled but
1018 Error low. Set EA parameter 'Initial SL for no Initial Risk Percent or Initial SL is
New Position' to higher than zero. configured. More...
2101 Error Initialization failed Initialization failed More...
The user quits the authentication
2118 Error Service access disabled (<Access| D>, process, or the EA isnot ableto
<ConfirmationlD>) - shutting down... authenticate the user accessto the
service. More...
9104 Error | Order submit failed at bid ... Broker server rejects orders submitted
by the EA. More...
Dynamic Target requires a Take .
15002 Error Profit. Set EA parameter Take Profit Dynamic t.ar.get fegture enabled but no
) Take Profit is configured. More...
to higher than zero.
Dynamic Stop requires a Take Profit. .
15004 Error Set EA parameter Take Profit to Dynamic ;tqp featgre enabled but no
. Take Profit is configured. More...
higher than zero.
6.1.1 Message 1001
Code Severity Message Description
) . Configuration setting is missing
aﬁ%g?';?;\ﬁ;b II:)TFI)_O:trrS] ngrtts to allow the EA to use dynamicaly
1001 Error in Comr.non tab of the pro ertri)es loaded libraries (DLLS). Enable the
. prop load of DLLs and restart the EA.
window. More
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Setup problem: DLL importsnot allowed

|ssue

The EA isnot able to start up when gets attached to a chart because some of its dependencies could not be loaded
into memory. The EA requires some dynamically loaded libraries (DLL) to be loaded into memory from disks.
When the EA configuration settings do not alow the load of DLL s then the EA cannot start up and reports this

error message.
Possible root cause

» TheEA configuration does not alow for the load of DLLs.

Resolution
Enable the load of DLLsin the EA configuration dialog.
1. Attach the EA to achart, or if already attached then select the chart and
* Incaseof an EA: press F7
* Incaseof anindicator: press Ctrl+l and double-click the name of the indicator in the list.
2. Go to the Common tab of the Property window.

3. Tick the checkbox Allow DLL imports.
4., Click OK.

Expert - ? *

About  Common  |nputs  Dependencies
Comman Safety
Allow DLL imparts

Long & Shot  ~ | postions

Allow import of external experts

Enable alers
[] Disable alert once hit

[ Mllow modification of Signals settings

Live Trading
I [ Alow live trading I

Cancel Reset

6.1.2 M essage 1002
Code Severity Message Description
Incomplete EA installation: Run Product installation is not cor_nplfate or
- ; damaged. Run the setup application
1002 Error setup application for MT4 instance for the MT4 terminal instance as
"<MT4DataPath>'s Data Folder" )
displayed. More...

Incomplete Installation

Issue

The EA isnot ableto start up when gets attached to a chart because some of its dependencies could not be found
on thefile system.

Possible root cause

» The EA setup application was not able to perform all its steps, not completed in full.
e The product was installed manually and some of the steps were missed.
» TheMT4 instance's file system got damaged, some files got corrupted or deleted.
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Resolution
Download the EA setup application and execute it to get the product installed for the M T4 instance:

1. Download the setup application from Web Support Centre.
2. Execute the setup application to get the product installed. For installation guide refer to any of the
following:
» Getting Started with the theTradeableADX EA
e Step-by-step Installation of Expertdx EAs and Indicators

6.1.3 Message 1006
Code Severity Message Description
MT4 Expert Advisors are disabled: EA does not perform its operations,
1006 Error click AutoTrading icon on MT4 not monitoring nor reacting to price
toolbar to execute the EA. movements of the market. More...

EA AutoTrading Disabled
Issue

The EA is not responding to price movements, not performing its logic upon data ticks coming in from the
broker. The MT4 toolbar button AutoTrading is disabled.

Possible root cause
* TheAutoTrading button on the M T4 toolbar is disabled.

its Tools  Window  Help

7 %Nmﬂrder & €@ AutoTrading 5|11, 8 I | & S & [[Ir Ik ||

MIE M20 | H1  H4 D1 Wl MM

mA T v |2 ML MS

Resolution

Press the AutoTrading button on the M T4 toolbar.

ks Tools  Window  Help

TG %Newﬂrder &5 |8 AutoTrading

LR k) Q e k]

SEON T %S ML OME MIE M0 | HL H4 D1 Wl MM

6.1.4 Message 1007
Code Severity Message Description
Livetrading is not allowed (no smiley | The EA isunableto perform trading
1007 Error face): press F7 and tick Allow live operations, thereisasad icon in the
trading box on Common tab. top right corner of the chart. More...

Live Trading Not Allowed

|ssue

The EA is unable to perform trading operations, thereis a sad icon in the top right corner of the chart.



https://my.eafactory.com/expert4x

Possible root cause

» TheAllow live trading checkbox is not ticked at the EA properties window.
Resolution
Enable live trading in the EA properties window.

1. Gotothe chart and press F7.

2. Go to the Common tab of the Expert properties window.
3. Tick the checkbox Allow live trading.

4. Click OK

About  Common  |mputs  Dependencies

Comman Safety
Long & Short ~ ~ | positions Allow DLL imports
Enable alerts Allow impaort of extemnal experts
[ ] Disable alert once Hit [] Allow modification of Signals settings
Live Trading

I [+ Mlow live trading I

Cancel Reset

Expert - 7 =

Operational Messages

6.1.5 Message 1008

Code Severity Message ToDo
Authentication failed or interrupted The EA is not able to authenticate the
(<Stopped>, <Status>, <Response>, : .

1008 Error : user access to the service at its start
<Reason>, <FlipOverCount>, .

up time. More...

<Latency>)

Failed Authentication

Issue

The EA is not able to authenticate the user access to the service at attach or restart time and does not start up.

Possible root cause

* TheEA could not connect to the authentication server.

» Theuser quit the authentication process.

e Thereisatypointhe Access D entered by the user.

» ThetheTradeableADX EA isnot yet purchased by the user.

» ThetheTradeableADX EA was purchased, but not yet activated by the user.

» ThetheTradeableADX EA was purchased or atrial started, but the licensed period (e.g. calendar days) has

lapsed.

e ThetheTradeableADX EA was purchased, but the licensed usage limit (e.g. number of parallel accesses) is

breached by the user.
Resolution

Double check the following items to find resolution to the issue.
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1. Ensure that the computer has working Internet connection. For example, go to the Web Support Centre and
seeif the page loads with no issues. When the Internet connection is working, restart the EA by pressing F7
and clicking the OK button of the Expert property window.

2. Ensure you enter the correct Access ID, case sensitive, without any typo, and click the Save button of the
Service Access Settings authentication window.

Unknown Access 0. Please enter
! i valid Access 1D,

Product :

Provider:

Access |0

Save Cancel

Dialog closesin Z2min 2 seconds

3. Ensure you have purchased the product. Log in to the Web Support Centre and select the theTradeableADX
EA from the product list. If the product is not available for download then it is yet to be purchased at the
Web Support Centre.

4. Count the number of computers you are running the theTradeableADX EA on. If it is more than what the
purchased EA licence copies allow then either shut down on the excess number of the computers all the
running theTradeableADX instances, or purchase more licence at the Web Support Centre.

6.1.6 Message 1017
Code Severity Message Description
Initial risk <InitialRiskPercent>% Position sizing feature is enabled but
1017 Error istoo low. Set EA parameter 'Initial no Initial Risk Percent or Initial SL is
Risk Percent' to higher than zero. configured. More...

Missing I nitial Risk Percent for Position Sizing Feature

|ssue

The position sizing feature is enabled and it requires both the Initial Risk Percent aswell asthe Initial SL to be set
higher than zero.

Possible root cause

» Thelnitial Risk Percent isturned off, set to value zero.
Resolution
Set the Initial Risk Percent to higher than zero value.

6.1.7 Message 1018
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Code Severity Message Description
Initial SL <Initial StopL oss> istoo Position sizing feature is enabled but
1018 Error low. Set EA parameter 'Initial SL for no Initial Risk Percent or Initial SL is
New Position' to higher than zero. configured. More...

Missing Initial SL for Position Sizing Feature

Issue

The position sizing feature is enabled and it requires both the Initial Risk Percent aswell asthe Initial S to be set
higher than zero.

Possibleroot cause

* Thelnitial SL isturned off, set to value zero.
Resolution
Set the Initial SL to higher than zero value.

6.1.8 Message 2101
Code Severity Message Description
2101 Error Initialization failed Initialization failed More...

I nitialization failed
|ssue
The EA dashboard shows that Initialization failed.

+ - Fade Shine

Status: HALTED Access: 0-0-0-0@pending Licensed until: pending

Possibleroot cause

* Your computer slowed down for some reason, and the EA could not start up in atimely manner.
» The EA shut down itself in order to reduce the load on your computer, and allow you to gain back
responsiveness of the computer, so you can free up some resources.

Resolution

Sometimes this can be associated with heavy swap usage by the operating system, which could be caused by
RAM shortage, or cycles of hibernation (close the lid of the laptop). The best way to clean this up isto simply
to reboot your computer: exit the M T4, shut your computer down and boot it up again. Do not start up any other
application just the MT4 and see if the EA can start up now, after the reboot.

6.1.9 Message 2118
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<Confirmationl D>) - shutting down...

Code Severity Message ToDo
The user quits the authentication
2118 Error Service access disabled (<AccessID>, process, or the EA isnot ableto

authenticate the user access to the
service. More...

Aborted Authentication

Issue

The EA is not able to authenticate the user access to the service at attach or restart time and does not start up.

Possibleroot cause

* Theuser quit the authentication process.

The EA could not connect to the authentication server.

Thereisatypointhe Access | D entered by the user.

The theTradeableADX EA is not yet purchased by the user.

The theTradeableADX EA was purchased, but not yet activated by the user.

The theTradeableADX EA was purchased or atrial started, but the licensed period (e.g. calendar days) has
ellapsed.

The theTradeableADX EA was purchased, but the licensed usage limit (e.g. number of parallel accesses) is
breached by the user.

Resolution

Double check the following items to find resolution to the issue.

1. Ensure that the computer has working Internet connection. For example, go to the Web Support Centre and
seeif the page loads with no issues. When the Internet connection is working, restart the EA by pressing F7
and clicking the OK button of the Expert property window.

. Ensure you enter the correct Access ID, case sensitive, without any typo, and click the Save button of the
Service Access Settings authentication window.

Unknown Access |D. Please enter

! valid Access 1D

Product:

Prowider:

Access D

Save Cancel

Diglog closesin Z2min 2 seconds

. Ensure you have purchased the product. Log in to the Web Support Centre and select the theTradeableADX
EA from the product list. If the product is not available for download then it is yet to be purchased at the
Web Support Centre.

. Count the number of computers you are running the theTradeableADX EA on. If it is more than what the
purchased EA licence copies allow then either shut down on the excess number of the computers all the
running theTradeableADX instances, or purchase more licence at the Web Support Centre.

6.1.10 Message 9104
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EA Code Severity Message Description
9104 Error | Order submit failed at bid ... Broker server rejects orders submitted
by the EA. More...

Order submit failed at bid

Issue

The theTradeableADX EA sends a trading request to the broker server which rejects the request due to an issue
on the broker side. The details of the broker side issue is described by the MT4 error code presented in the EA
dashboard right below the red error message - here is an example:

MT4:129 invalid price

Possible root cause

In your MT4 chart, observe the MT4 error code displayed in the EA dashboard. Find that MT4 code in the below
table and click on that number to see the details and possible resolutions:

MT4 Code Severity Message Description
> Error Common error Connection, broker account or market
' related error. More...
The market price moved in the
129 Error Invalid price. meanwhile making the price in the
order not feasible. More...
132 Error Market is closed. M af"e‘ Is closed, trading is not
available. More...
No current prices available or a
136 Error Off quotes. broker configured limit breached.
More...
, The broker account does not allow for
Amount of open and pending orders .
148 Error - more open or pending orders on the
has reached the limit.
account. More...
6.1.11 M essage 15002
Code Severity Message Description
Dynamic Target requires a Take .
15002 Error Profit. Set EA parameter Take Profit Dynamic t.ar.get fee}ture enabled but no
) Take Profit is configured. More...
to higher than zero.

Missing Take Profit for Dynamic Target Feature

|ssue

The Dynamic Target feature is enabled and it requires the Take Profit to be set higher than zero. Refer to
Dynamic Target for more details.

Possible root cause

* The Take Profit is turned off, set to value zero.

Resolution

Set the Take Profit to higher than zero value.
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Dynamic Target
6.1.12 M essage 15004
Code Severity Message Description
Dynamic Stop requires a Take Profit. .
15004 Error Set EA parameter Take Profit to Dynamic ;tqp featgre enabled but no
. Take Profit is configured. More...
higher than zero.

Missing Take Profit for Dynamic Stop Feature

Issue

The Dynamic Stop feature is enabled and it requires the Take Profit to be set higher than zero. Refer to Dynamic
Stop for more details.

Possibleroot cause
* The Take Profit is turned off, set to value zero.

Resolution

Set the Take Profit to higher than zero value.
Related reference

Dynamic Stop

6.2 MetaTrader Operational M essages

MetaTrader Operational Messages.

MetaTrader Operational M essages

Observe the message number displayed in white in the EA dashboard. Find that MT4 code in the table below and
click on that number to see the details and possible resolutions:

MT4:132 inatket is closed

MT4 Code Severity Message Description
5 Error Common error Connection, broker account or market
' related error. More...

The market price moved in the

129 Error Invalid price. meanwhile making the pricein the
order not feasible. More...

132 Error Market is closed. M ""Tke‘ Is closed, trading is not
available. More...

133 Error Trade is disabled. Broker disabled trading on this
account. More...
No current prices available or a

136 Error Off quotes. broker configured limit breached.
More...
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MT4 Code Severity Message Description

Amount of open and pending orders The broker account does not allow for

148 Error has reached the limit. more open or pending orders on the
account. More...
4024 Error Internal error. MT4 terminal interna issue. More...
6.2.1 M T4 Message 2
MT4 Code Severity Message Description
5 Error Common error Connection, broker account or market
’ related error. More...

MT4 Message: Common error

Issue

MT4:2 common emor

© 2020.11.12 12:49:48.832
© 2020.11.1212:49:48.832
© 2020.11.12 12:49:48.738
© 2020,11.1212:49:48.738
© 2020.11.12 12:49:48,567
© 2020,11.12 12:49:48,567
@ 2020,11.12 12:49:48,567
T @ 2020.111212:49:48.567

(MT4 Code:2 De:
360) (MT4

z S
5[ Tiade | Exposure | AccountHistory | News | Alerts | Mailbox; | Marketyss | Signals | Articles | CodeBase | Experts | Joumal |

For Help, press F1 Default 2020.11.0304:00 | 0:132124 | H:132343 | ;132068 | C:132279 |v: 22088 | fiii 7322

The EA dashboard shows that there is a'common error' on the M T4 level which blocks the communication or
trading with the broker server. This may occur after alost connection over the Internet to the broker server where
the reconnection did not succeed properly, or due to some other account or market related issue.

Resolution

Restart your MT4: In the MT4 menu select File > Exit, wait 5 seconds then start it up again. Hopefully the EA
‘code 2, common error' would get cleared and the MT4 would be able to operate fully again.

When the demo broker account expires this message may turn up. In this case create a new demo account with the

broker.
6.2.2 MT4 Message 129
MT4 Code Severity Message Description

The market price moved in the
129 Error Invalid price. meanwhile making the price in the
order not feasible. More...

MT4 Message: Invalid price

Issue

MT4:129 invalid price
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The EA dashboard shows that the order failed because of the market price moved on by the time the order
reached the broker, which can happen in trading on a daily basis.

Resolution

In this case the EA automatically sends a new order according to the new market price and recovers from this
issue on its own.

Watch out for the 'Count:' figure at the end of the red error message. Only if the Count figure would keep
increasing every few seconds or so for longer than 5 - 10 minutes then a closer ook would be needed. That
could be an indication of a permanent issue which may need investigation and intervention. In this case send a
screenshot of the chart showing the EA dashboard including the error message in full to support.

6.2.3MT4 Message 132
MT4 Code Severity Message Description
132 Eror | Marketis closed. Market i closed, trading is not
available. More...

MT4 Message: Market isclosed

|ssue

MT4:132 market is closed

The EA dashboard shows that the root cause of the issue was that the broker closed the trading of the market at
around midnight GMT broker time.

Resolution

Thisis probably due to the practice the broker switches liquidity providers (banks) at around midnight GMT
when the EU/US session ends and the Asian session kicksin. The switchover period could be just afew minutes
but may last up to an hour or so around midnight GMT. Asthe Count: figureisincreasing only over this short
switchover period thisis only atemporary issue.

The EA automatically recovers from this situation on its own and sends new orders to the broker when the market
becomes open for trading again.

Watch out for the 'Count:' figure at the end of the red error message. If the Count figure increases only during the
midnight GMT switchover period then no further action or intervention is needed. However, if the Count figure
would keep increasing at any time of the day (not only around midnight GMT) every few seconds or so for longer
than 5 - 10 minutes then a closer look would be needed. That could be an indication of a permanent issue which
may need investigation and intervention. In this case send a screenshot of the chart showing the EA dashboard
including the error message in full to support.

6.2.4 MT4 Message 133
MT4 Code Severity Message Description
133 Error Tradeis disabled. Broker disabled trading on this
account. More...

MetaTrader Message: Tradeisdisabled

|ssue
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The theTradeableADX EA got attached to a chart, the EA is up and running. It keeps submitting market ordersto
the broker server. However, the broker's server does not execute these market orders, instead, the broker saysthe
trade on this broker account is disabled:

MT4:133 trade is disabled

The broker server reports the MT4 error code 133, which means that the tradeis disabled on the account. This
isnot an EA issue, instead, thisis an issue with the broker account. For some reason the broker account does not
alow you to trade that market.

Resolution
Go through the following checklist to resolve thisissue:

1. Restart the MT4 terminal to seeif the restart and reconnect to the broker resolves this: In the MT4 menu
select File > Exit, wait 5 seconds then start the MT4 up again.

2. ldentify another symbol for the same market which is enabled for trading: In the MT4 menu select View >
Symbols and search for symbol with different/extra suffix in the name, like EURUSDecn. Add that symbol
to the Market Watch window then attach the EA to this new symboal.

3. Logging into your MT4 broker account with the investor login credentials disables trading. Ensure that you
log in to your broker account with the full trader login credentials.

4. Create another demo account with the broker.
5. Contact your broker and ask their support team to enable trading on the symbol or account

1. Your broker account may have reached some trade limits (e.g. overall maximum lots).
2. Your broker may have put (temporarily) trading limitations on your account for some reason.
3. Your broker may have to enable trading by EAs.

6.2.5MT4 Message 136
MT4 Code Severity Message Description
No current prices available or a
136 Error Off quotes. broker configured limit breached.
More...

MT4 Message: Off quotes

|ssue

MT4:138 off quotes

The EA dashboard shows that the order failed because of the current market prices are not available due to
connectivity issues, or because some of the broker constraints got breached by the order, like quotes got outdated
or moved too far away.

Resolution

The EA automatically sends a new order according to the new market conditions and recovers from this issue on
its own. Thereis no need for any intervention.

6.2.6 MT4 Message 148
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MT4 Code Severity Message Description

The broker account does not allow for
more open or pending orders on the
account. More...

Amount of open and pending orders

148 Brror | pas reached the limit.

MT4 Message: Amount of open and pending orders hasreached the limit

Issue

MT4:148 amount of cpen and pending orders has reached the limit

Based on the M T4 error code 148 the number of open trades reached the limit of the broker account, i.e. there are
too many open trades on the account and no more trade can be entered. Thisis a broker account limitation, not an
EA limitation.

Resolution

The number of open trades needs to be reduced on the broker account. If you run multiple EAs on the account
then close some of those charts with the EAs and close the corresponding trades off. Y ou may consider to open
another broker account and start those EAs up on that new broker account.

Y ou could also limit the number of trades this EA can open on the account - see the

6.2.7 M T4 Message 4024
MT4 Code Severity Message Description
4024 Error Internal error. MT4 terminal internal issue. More...

MT4 Message: Internal error

Issue
Time Message

2020.11.03 07:35:36.832 : INFO[1237;1050018]: Start cleanup:4024 internal error
@ 2020.11.03 07:35:27.545 WARN[3017;1050018]: 489:4024 internal error (MT4 Code:4024 Desc.internal error)
@ 2020.11.03 07:33:58.024 INFO[1237;1050018]: Start cleanup:4024 internal error
@ 2020.11.03 07:33:23.661 INFO[1237;1050018]: Start cleanup:4024 internal error
@ 2020.11.03 07:33:09.540 INFO[1237;1050018]: Start cleanup:4024 internal error
@ 2020.11.03 07:32:41.520 INFO[1237;1050018]: Start cleanup:4024 internal error
@ 2020.11.03 07:31:12410 INFO[1237;1050018]: Start cleanup:4024 internal error
@ 2020.11.03 07:30:38.469 INFO[1237;1050018]: Start cleanup:4024 internal error
@ 2020.11.03 07:30:23.871 INFO[1237;1050018]: Start cleanup:4024 internal error

The MT4 Expert tab shows that there isa'internal error' in the MT4.

The 4024 comes up when the MT4 is busy, and some request from the EA, like to refresh the chart area, cannot
be processed without delay. Thisis an internal issue to the MT4 due to a busy or overloaded environment. The
impact of thisissueisthat the chart area may get refreshed with some delay. However, in extreme cases this may
become an issue impacting the trading as well.

Resolution

If you get this 4024 only occasionally, a couple of times a day then you may ignore this message. However,

if you get this message very regularly, then your MT4 or computer could be overloaded or its performance
degraded. In this case exit your M T4, reboot your computer, and only start the MT4 up and no other applications
which you do not use. If you still get 4024 messages then close some of the charts, detach some of the EAsin
your MT4. Thisisto reduce the load on your computer and to eliminate this message.



Chapter

v

Support

Please contact support@eafactory.com if you require any further assistance. Please copy info@expert4x.com on
your email.
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